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Conventions

Standardized conventions have been used in this manual to assist 
you in visually locating and identifying information quickly.

Symbols

CAUTION: This symbol alerts you to an action that may cause 
damage to hardware, software, or result in the loss of data.

WARNING: Warnings mark alert users to areas of the machine 
where there is a possibility of personal injury.

WARNING: This symbol identifies an area on the machine that is 
HOT and should not be touched.

WARNING: This symbol indicates a laser is being used in the 
machine and alerts you to refer to the appropriate safety 
information.

KEY POINT: This symbol identifies information that is being 
emphasized and is important for you to remember.
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Conventions
The 1 2 3... symbol indicates the beginning of a task or work 
process you should use to complete a procedure and is followed 
by the first step of a numbered procedure, task, or work process.

NOTE: This symbol calls your attention to information that is 
helpful, but not essential to complete a procedure or task.

This symbol indicates that there is additional information from 
another source, such as a web site or manual.

Writing style conventions

• Bold type indicates the name of a button to press or touch.
• Underlining is used to emphasize a word or term.
• Italic type is used for the text associated with symbols such as 

Notes to visually bring the information to your attention.
• Italic type is also used to indicate names, such as the name of 

a chapter, or the name of a screen.
• Procedures direct you to press buttons located on the Control 

Panel, and touch buttons located on the Touch Screen.
• Text referring to illustrations or screen samples precedes the 

image.
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Safety notices

This Xerox product and the recommended supplies are designed 
and tested to meet strict safety requirements. These include 
safety agency approval and compliance to established 
environmental standards. Please read the following instructions 
carefully before operating the product, and refer to them as 
needed to ensure the continued safe operation of your product.
KEY POINT: The safety testing and performance of this product 
have been verified using Xerox materials only.
WARNING: Any unauthorized alteration, which may include the 
addition of new functions or connection of external devices, may 
impact the product certification. Please contact your authorized 
local dealer for more information.

Electrical safety

• Use only the power cord supplied with this equipment.
• Plug the power cord directly into a correctly grounded 

electrical outlet. Do not use an extension cord. If you do not 
know whether or not an outlet is grounded, consult a qualified 
electrician.

• Do not use a ground adapter plug to connect this equipment to 
an electrical outlet that lacks a ground connection terminal.

WARNING: You may incur a severe electrical shock if the outlet is 
not grounded correctly.
• Do not place the press where people may step or trip on the 

power cord. Do not place objects on the power cord.
• Do not override or disable electrical or mechanical interlocks.
• Do not obstruct the ventilation openings. These openings 

prevent overheating of the machine.
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Safety not ices
WARNING:  Never push objects of any kind into slots or openings 
on this equipment. Making a contact with a voltage point or 
shorting out a part may result in fire or electrical shock.
If any of the following conditions occur, immediately switch off the 
power to the machine and disconnect the power cord from the 
electrical outlet. Call an authorized Xerox service representative 
to correct the problem.
• The machine emits unusual noises or odors.
• The power cord is damaged or frayed.
• A wall panel circuit breaker, fuse, or other safety device is 

tripped.
• Liquid is spilled into the press.
• The machine is exposed to water.
• Any part of the machine is damaged.

Disconnect device

The power cable is the disconnect device for this equipment and is 
attached to the back of the machine as a plug-in device. To 
remove all electrical power from the machine, disconnect the 
power cable from the electrical outlet.
WARNING: This product must be connected to a protective earth 
current.
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Safety not ices
Laser safety

North America

This product complies with safety standards and is certified as a 
Class 1 Laser product under the Center for Devices and 
Radiological Health (CDRH) of the United States Food and Drug 
Administration (FDA) implemented regulations for laser 
products. This product complies with FDA 21 CFR 1940.10 and 
1040.11 except for deviations pursuant to Laser Notice No. 50, 
dated July 26, 2001. These regulations apply to laser products 
marketed in the United States. The label on the machine indicates 
compliance with CDRH regulations and must be attached to laser 
products marketed in the United States. This product does not 
emit hazardous laser radiation.
CAUTION: Use of controls or adjustments or performance of 
procedures other than those specified herein may result in 
hazardous exposure of laser light.
Since radiation emitted inside this product is completely confined 
within the protective housing and external covers, the laser beam 
cannot escape from the machine during any phase of the user 
operation.
This product contains laser warning labels. These labels are 
intended for use by the Xerox Service Representative and are 
placed on or near panels or shields that require special tools for 
removal. Do not remove any of the panels. There are no operator 
serviceable areas in these covers.
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Safety not ices
Europe (EU) and other markets

This product complies with IEC’s safety standard 60825-1 (Edition 
1.2) issued August 2001.
The equipment complies with laser product performance 
standards set by governmental, national, and international 
agencies as a Class 1 Laser Product. It does not emit hazardous 
radiation as the beam is totally enclosed during all phases of 
customer operation and maintenance.
CAUTION: Use of controls or adjustments or performance of 
procedures other than those specified herein may result in 
hazardous radiation exposure.
This product contains laser warning labels. These labels are 
intended for use by the Xerox Service Representative and are 
placed on or near panels or shields that require special tools for 
removal. Do not remove any of the panels. There are no operator 
serviceable areas inside these covers.
If you need additional safety information concerning the product or 
Xerox supplied materials, you may call the following number:

+44 (0) 1707 353434

Safety standards

North America

This Xerox product is safety certified by Underwriters Laboratories 
Incorporated to Standards UL60950-1 (first edition), and CSA 
International CAN/CSA C22.2 No. 60950-1-03 (First Edition).

Europe (EU) and other markets

This Xerox product is safety certified by Underwriters Laboratories 
Incorporated to publication IEC60950-1 (2001) First Edition.
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Safety not ices
Maintenance safety

• Do not attempt any maintenance procedure that is not 
specifically described in the documentation supplied with your 
product.

• Do not use aerosol cleaners. The use of supplies that are not 
approved may cause poor performance of the press and could 
create a dangerous condition.

• Use the supplies and cleaning materials only as directed in 
this manual. Keep all materials out of the reach of children.

• Do not remove the covers or guards that are fastened with 
screws. There are no parts behind these covers that you can 
maintain or service.

Do not perform any maintenance procedures unless you have 
been trained to do them by a Xerox representative, or unless a 
procedure is specifically described in one of the manuals included 
with your press.

Operational safety

Your Xerox equipment and supplies were designed and tested to 
meet strict safety requirements. These include safety agency 
examination, approval, and compliance with established 
environmental standards.
Your attention to the following safety guidelines will help ensure 
the continued safe operation of your product:
• Use the materials and supplies specifically designed for your 

product. The use of unsuitable materials may result in poor 
performance of the machine and possibly a hazardous 
situation.

• Follow all warnings and instructions that are marked on or 
supplied with the machine.

• Place the machine in a room that provides adequate space for 
ventilation and servicing.

• Place the machine on a level, solid surface (not on a thick pile 
carpet) that has adequate strength to support the weight of the 
machine.

• Do not attempt to move the machine. A leveling device that 
was lowered when your machine was installed may damage 
the carpet or floor.

• Do not set up the machine near a heat source.
• Do not set up the machine in direct sunlight.
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Safety not ices
• Do not set up the machine in line with the cold air flow from an 
air conditioning system.

• Do not place containers of coffee or other liquid on the 
machine.

• Do not block or cover the slots and openings on the machine.
• Do not attempt to override any electrical or mechanical 

interlock devices.

WARNING: Be careful when working in areas identified with this 
warning symbol. These areas may be very hot and should not be 
touched.
If you need any additional safety information concerning the 
machine or materials, contact your Xerox representative.

Ozone safety

This product produces ozone during normal operation. The ozone 
is heavier than air, and the quantity is dependent on print volume. 
Providing the correct environmental parameters, as specified in 
the Xerox installation procedures, ensures that concentration 
levels meet safe limits.
If you need additional information about ozone, request the Xerox 
publication, OZONE by calling 1-800-828-6571 in the USA. For a 
French language version, call 1-800-828-6571 in the USA, then 
press 2.
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Notices

Radio frequency emissions

FCC in the USA

This equipment has been tested and found to comply with the 
limits for a Class A digital device, pursuant to Part 15 of the 
Federal Communications Commission (FCC) Rules. These limits 
are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment 
in a residential area is likely to cause harmful interference in which 
case the user will be required to correct the interference at his/her 
own expense.
Changes or modifications to this equipment not specifically 
approved by the Xerox Corporation may void the user’s authority 
to operate this equipment.
WARNING: Shielded cables must be used with this equipment to 
maintain compliance with FCC regulations.

In Canada (ICES-003)

This Class “A” digital apparatus complies with Canadian ICES-
003.
Cet appareil numérique de la classe “A” est conforme á la norme 
NMB-003 du Canada.
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Notices
Regulatory information for RFID

This product generates 13.56 MHz using an Inductive Loop 
System as a Radio Frequency IDentification system device 
(RFID). This system is certified in compliance with European 
Council Directive 99/5/EC and applicable local laws or regulations 
as applicable.

Safety extra low voltage approval

This Xerox product is in compliance with various governmental 
agencies and national safety regulations. All system ports meet 
the Safety Extra Low Voltage (SELV) circuits for connection to 
customer-owned devices and networks. Additions of customer-
owned or third-party accessories that are attached to the press 
must meet or exceed the requirements previously listed. All 
modules that require external connection must be installed per the 
installation procedure.
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Certifications in Europe

The CE marking that is applied to this product symbolizes Xerox 
Declaration of Conformity with the following applicable Directives 
of the European Union as of the dates indicated:

January 1, 1995: Council Directive 73/23/EEC amended by Council Directive 93/68/
EEC, approximation of the laws of the member states related to 
low voltage equipment.

January 1, 1996: Council Directive 89/336/EEC, approximation of the laws of the 
member states related to electromagnetic compatibility.

March 9, 1999 Council Directive 99/5/EC on radio equipment and 
telecommunications terminal equipment and the mutual 
recognition of their conformity.
A full declaration, defining the relevant directives and referenced 
standards, can be obtained from your Xerox Limited 
representative or by contacting:

Environment, Health and Safety
The Document Company Xerox
Bessemer Road
Welwyn Garden City
Herts
AL7 1HE
England
Tel Number +44 (0) 1707 353434

WARNING: This system is certified manufactured and tested in 
compliance with strict safety and radio frequency interference 
regulations. Any unauthorized alteration which includes the 
addition of new functions or the connection of external devices 
may impact this certification. Please contact your local Xerox 
Limited representative for a list of approved accessories.
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Notices
WARNING: In order to allow this equipment to operate in 
proximity to Industrial, Scientific, and Medical (ISM) equipment, 
the external radiation from the ISM equipment may have limited or 
special mitigation measures taken.
WARNING: This is a Class A product in a domestic 
environment. This product may cause radio frequency 
interference in which case the user may be required to take 
adequate measures.
WARNING: Shielded cables must be used with this equipment to 
maintain compliance with Council Directive 89/336/EEC.

It’s illegal in the USA

Congress, by statute, has forbidden the reproduction of the 
following subjects under certain circumstances. Penalties of fine 
or imprisonment may be imposed on those guilty of making such 
reproductions.

1. Obligations or Securities of the United States Government, 
such as:
Certificates of Indebtedness National Bank Currency
Coupons from Bonds Federal Reserve Bank Notes
Silver Certificates Gold Certificates
United States Bonds Treasury Notes
Federal Reserve Notes Fractional Notes
Certificates of Deposit Paper Money
Bonds and Obligations of certain agencies of the government, 
such as FHA, etc.
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Notices
Bonds. (U.S. Savings Bonds may be photographed only for 
publicity purposes in connection with the campaign for the sale 
of such bonds.)
Internal Revenue Stamps. (If it is necessary to reproduce a 
legal document on which there is a canceled revenue stamp, 
this may be done provided the reproduction of the document is 
performed for lawful purposes.)
Postage Stamps, canceled or uncanceled. (For philatelic 
purposes, Postage Stamps may be photographed, provided 
the reproduction is in black and white and is less than 75% or 
more than 150% of the linear dimensions of the original.)
Postal Money Orders.
Bills, Checks, or Drafts of money drawn by or upon authorized 
officers of the United States.
Stamps and other representatives of value, of whatever 
denomination, which have been or may be issued under any 
Act of Congress.

2. Adjusted Compensation Certificates for Veterans of the World 
Wars. 

3. Obligations or Securities of any Foreign Government, Bank, or 
Corporation.

4. Copyrighted material, unless permission of the copyright 
owner has been obtained or the reproduction falls within the 
“fair use” or library reproduction rights provisions of the 
copyright law. Further information of these provisions may be 
obtained from the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21.

5. Certificates of Citizenship or Naturalization. (Foreign 
Naturalization Certificates may be photographed.)
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Notices
6. Passports. (Foreign Passports may be photographed.)

7. Immigration Papers.

8. Draft Registration Cards.

9. Selective Service Induction Papers that bear any of the 
following Registrant’s information:
Earnings or Income Dependency Status
Court Record Previous military service
Physical or mental condition
Exception: United States military discharge certificates may be 
photographed.

10.Badges, Identification Cards, Passes, or Insignia carried by 
military personnel, or by members of the various Federal 
Departments, such as FBI, Treasury, etc. (unless photograph 
is ordered by the head of such department or bureau.)
Reproducing the following is also prohibited in certain states: 
Automobile Licenses - Drivers’ Licenses - Automobile 
Certificates of Title.

The above list is not all inclusive, and no liability is assumed for its 
completeness or accuracy. In case of doubt, consult your attorney.
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Notices
It’s illegal in Canada

Parliament, by statute, has forbidden the reproduction of the 
following subjects under certain circumstances. Penalties of fines 
or imprisonment may be imposed on those guilty of making such 
copies. 

1. Current bank notes or current paper money.

2. Obligations or securities of a government or bank.

3. Exchequer bill paper or revenue paper.

4. The public seal of Canada or of a province, or the seal of a 
public body or authority in Canada, or of a court of law.

5. Proclamations, orders, regulations or appointments, or notices 
thereof (with intent to falsely cause same to purport to have 
been printed by the Queen’s Printer for Canada, or the 
equivalent printer for a province).

6. Marks, brands, seals, wrappers or designs used by or on 
behalf of the Government of Canada or of a province, the 
government of a state other than Canada or a department, 
board, Commission or agency established by the Government 
of Canada or of a province or of a government of a state other 
than Canada.

7. Impressed or adhesive stamps used for the purpose of 
revenue by the Government of Canada or of a province or by 
the government of a state other than Canada.

8. Documents, registers or records kept by public officials 
charged with the duty of making or issuing certified copies 
thereof, where the reproduction falsely purports to be a 
certified copy thereof.

9. Copyrighted material or trademarks of any manner or kind 
without the consent of the copyright or trademark owner.

The above list is provided for your convenience and assistance, 
but it is not all inclusive, and no liability is assumed for its 
completeness or accuracy. In case of doubt, consult your solicitor.
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Notices
Environmental notices for the USA

As an ENERGY STAR® partner, Xerox Corporation has 
determined that this product meets the ENERGY STAR guidelines 
for energy efficiency.
The ENERGY STAR and ENERGY STAR MARK are registered 
United Stated trademarks.
The ENERGY STAR Office Equipment Program is a team effort 
between U.S., European Union and Japanese governments, and 
the office equipment industry to promote energy-efficient copiers, 
printers, fax, multifunction machines, personal computers, and 
monitors. Reducing product energy consumption helps combat 
smog, acid rain, and long-term changes to the climate by 
decreasing the emissions that result from generating electricity.
Xerox ENERGY STAR equipment is preset at the factory. Your 
machine will be delivered with the timer for switching to Low 
Power Mode from the last copy/print output, set at 15 
minutes. The time to switch to power save (auto off/sleep) mode 
is set at 60 minutes from the last copy/print output. A more 
detailed description of the Power Saver Mode, together with 
instructions on changing the default time to suit your work pattern, 
can be found in the System Administration Guide, System Timers, 
Power Saver section.
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Notices
Environmental notices for Canada

Terra Choice Environmental Services, Inc. of Canada has verified 
that this Xerox product conforms to all applicable Environmental 
Choice EcoLogo requirements for minimized impact to the 
environment.

As a participant in the Environmental Choice program, Xerox 
Corporation has determined that this product model meets the 
Environmental Choice guidelines for energy efficiency.
Environment Canada established the Environmental Choice 
program in 1988 to help consumers identify environmentally 
responsible products and services. Copier, printer, digital press, 
scanners, and fax products must meet energy efficiency and 
emissions criteria, and exhibit compatibility with recycled supplies. 
Currently, Environmental Choice has more than 1600 approved 
products and 140 licensees. Xerox has been a leader in offering 
EcoLogo approved products. In 1996, Xerox became the first 
company licensed to use the Environmental Choice EcoLogo for 
its copiers, printers, and fax machines.
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Notices
Product recycling and disposal

If you are managing the disposal of your Xerox product, please 
note that the product contains lead and other materials whose 
disposal may be regulated due to environmental 
considerations. The presence of lead is fully consistent with 
global regulations applicable at the time that the product was 
placed on the market.

North America

Xerox operates a worldwide equipment take-back and reuse/
recycle program. Contact your Xerox sales representative (1-800-
ASK-XEROX) to determine whether this Xerox product is part of 
the program. For more information about Xerox environmental 
programs, visit www.xerox.com/environment.
For recycling and disposal information, contact your local 
authorities. In the United States, you may also refer to the 
Electronic Industries Alliance web site: www.eiae.org.
If your product is not part of the Xerox program and you are 
managing its disposal, please follow the instructions provided in 
the above paragraph.

European union

Application of this symbol on your equipment is confirmation that 
you must dispose of this equipment in compliance with agreed 
national procedures.
In accordance with European legislation end-of-life electrical and 
electronic equipment subject to disposal must be managed within 
agreed procedures.
Prior to disposal, contact your local dealer or Xerox representative 
for end-of-life take-back information.

Other countries

Please contact your local waste authorities and request disposal 
guidance.
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1. Overview

The Xerox FreeFlow Scanner 665E is a Xerox color-enabled 
scanner that interfaces with FreeFlow software. The scanner is 
an optional accessory that is used in conjunction with the 
DocuColor 8000/7000 Digital Press.
The FreeFlow Scanner 665E is capable of:
• Scanning color images at 600 x 600 dots per inch (dpi).
• Providing the same resolution and ranges for both Platen and 

Automatic Document Feeder (ADF) scanning.
• Providing electronic page (ADF) deskew for color and black 

and white.
NOTE: The scanner only deskews what the ADH may have 
skewed during the scanning process.

• Providing color scaling, ranging from 11-100% at 600 dpi and 
22-200% at 300 dpi.

The scanner provides the following controls:
• Hue rotation which allows you to shift the entire spectrum of 

the image by an equal amount.
• Color cast adjustment control which allows for correction of the 

image to remove small amounts of unwanted color tints.
• Saturation control which allows you to adjust the intensity of all 

color. You can decrease intensity until a gray image devoid of 
color is achieved. You can increase intensity until colors over 
saturate.
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1.  Overv iew
Hardware overview

The Xerox FreeFlow Scanner 665E is a high quality, high volume 
scanner. Teamed with scanning software and a personal 
computer, the scanner is a powerful tool for capturing and 
manipulating graphics and text.

Scanner components

The scanner is comprised of the following components:
• Control panel
• Power switch
• Automatic Document Feeder (ADF)
• Document Glass
• SCSI connection
• SCSI cable
• Power cord
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1.  Overv iew
Control Panel

The scanner includes a control panel on the front right corner. Use 
these controls to start and stop scans as well as monitoring the 
status of the scanner.

The control panel consists of the following components:

Start button (green): Press this button to start a scan.

Stop button (red): Press this button to cancel a scan. The page currently being 
scanned will complete the scan process.

Status LED (green): Remains constantly lit when the scanner is ready to scan and is 
dark whenever a scan is in progress.

Fault LED (yellow): Flashes when a fault has occurred, requiring corrective action.

Power switch

The on/off switch is located on the rear of the right side panel.

When you switch on the power, a yellow status LED on the control 
panel begins to flash. Wait until the scanner makes an audible 
"click" sound and the green status LED lights before turning on 
power to the PC.
For more information about powering on/off the system, refer to 
page 1-15.

Power switch
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1.  Overv iew
Automatic Document Feeder (ADF)

The Automatic Document Feeder has the following features:

Automatic 2-sided
scanning:

When two-sided originals are scanned, the front (top) side is 
scanned first. The original is then turned over and passed through 
the ADF to scan the back side. Finally, it is turned over a second 
time before being ejected into the Document Output Tray face 
down, thus maintaining the original order of the document stack.

Feeds many document
types, including:

• Documents from 6.5 x 5.5 inches to 11.7 x 17 inches 
• Documents with minor damage, such as slightly curled paper 
• Hole-punched stock 
• 13 to 32 lb. (49 to 120 gsm) uncoated stock 

High-speed scanning: • 65 images per minute in black and white 
• 30 images per minute in grayscale 
• 20 images per minute in color 
• 100 sheet capacity (20 lb. uncoated stock)

Ability to separate the ADF
from the Document Glass

Cover

The Automatic Document Feeder (ADF) separates from the 
Document Glass cover with a latch on the front edge of the ADF/
Document Glass cover assembly. This aids in jam clearance and 
for scanning bound documents with many pages. With the 
Document Glass cover separated from the Document Feeder, it 
will close and contact the bound document with even pressure.

ADF
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1.  Overv iew
Document Glass

Raise the entire ADF and Document Glass Cover Assembly to 
access the Document Glass.

The Document Glass provides a 12 x 18 inch (304.8 mm x 457.2 
mm) scanning area and has standard and book registration 
guides. Scan directly from the Document Glass if you are 
scanning an image on photographic paper or you are scanning a 
delicate or damaged document. 

SCSI Connection

SCSI stands for Small Computer System Interface. It is 
pronounced 'scuzzy,'
SCSI is the protocol that lets your PC communicate with the Xerox 
Scanner. When using a SCSI peripheral device (the scanner), 
you must first power on the peripheral device (scanner) before 
powering on the PC. Wait for the scanner to complete its 
calibration sequence and for the status LED (green) to light before 
powering on the PC.
The SCSI connection is located on the middle of the rear panel.

The scanner requires a dedicated SCSI connection. 

Document glass

SCSI connection
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1.  Overv iew
SCSI Cable

A 9.8 foot (3 m) SCSI cable is provided with your Xerox Scanner. 
This cable enables communication between the scanner and the 
host PC.

Power Cord

Plug the power cord into the scanner at the left rear panel.

The scanner requires a 10 amp 115 VAC connection in the United 
States or Canada, and a 5 amp 240 VAC connection in Europe. 
Contact an electrician if your electrical service does not match 
these requirements.

SCSI cable

Power cord
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1.  Overv iew
Overview of FreeFlow applications

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

The FreeFlow applications include the following:

Production Printer
Settings:

This application consists of the following functions:
• Adding, editing, and deleting a printer
• Setting a default printer
• Checking the printer and/or job status
• Creating a job ticket

The Production Printer Settings application is discussed in more 
detail in Chapter 2 on page 2-1.
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1.  Overv iew
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

Scan and Print: This application provides a quick, easy way to scan, print, and 
save documents. It also allows you to apply enhancements, 
headers, footers, and page numbers to your scan jobs.

The Scan and Print application is discussed in more detail in 
Chapter 3 on page 3-1.

Application
title bar

Menu bar

Click this
button to

Scan, Print, and
Save buttons

Click this button
to cancel all

Scan and
Print options

Message area

selections and cancel the job
return to system
defaults

Click this 
button to
access
additional
scanning
features

Click this
button to
access the
Job Setup/
Job Ticket
options
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1.  Overv iew
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

Advanced Scanning: The Advanced Scanning options are accessed from the Scan and 
Print window by clicking the button. The Advance Scanning 
provides more scanning options and allows you to better define 
the scanning parameters of your original document.

Advanced Scanning is discussed in more detail in Chapter 4 on 
page 4-1.
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1.  Overv iew
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

Job Ticket/Job Setup: The Job Ticket/Job Setup options are accessed either from the 
Production Printer Settings application or from the Scan and Print 
application.

A job ticket is an electronic record that specifies printing and 
finishing options for a document. The job ticket options available 
for your document are listed in the Job Setup dialog box.
The Job Ticket/Job Setup options are discussed in more detail in 
Chapter 2 on page 2-9 and in Chapter 5 on page 5-1.
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1.  Overv iew
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

Quick Print: This application is available on the scanner and also can be 
installed and executed from client workstations on which have the 
required PC platform software loaded. Quick Print allows you to 
retrieve and print documents that are already set up, ready to 
print, and are stored in a digital format, such as RDO, PostScript 
(PS), PDF, TIFF, JPEG, HP/PCL, or ASCII.

Quick Print is discussed in more detail on Chapter 6 on page 6-1.
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1.  Overv iew
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

File Manager: The FreeFlow File Manager application allows you to manage 
your Raster Document Object (RDO) files. Use the FreeFlow File 
Manager to copy, move, rename, and/or delete an RDO file.

KEY POINT: Do not confuse Windows Explorer with the FreeFlow 
File Manager. While they look basically the same, the FreeFlow 
File Manager is where you manage compound document objects 
like RDOs as a single object. Furthermore, Windows Explorer 
cannot handle compound objects like RDOs, so you could corrupt 
your RDOs if you try to copy, move, delete, or rename these 
objects within Windows Explorer.
File Manager and its features is discussed in more detail on 
Chapter 7 on page 7-1.
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KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

Security Certification: If your site requires a high security communication and you are 
connected to a DocuSP color server, you will this application.

Security Certification is discussed in more detail on Chapter 8 on 
page 8-1.
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Workstation platform

The following table lists the required hardware components for the 
scanner workstation platform:

Required workstation platform

Workstation platform Description

DELL OptiPlex The FreeFlow workstation platform:
• 3.0 GHz Single P4 CPU w/1 MB L2-Cache, 

800 MHz FSB
• 915G or GX520 Chipset
• 1 GB of memory
• Single 80 GB SATA 7200 RPM Hard Disk
• Integrated Graphics Controller
• Adaptec Dual Port 39160 SCSI Adapter Card
• 48x CD-RW/DVD combo with IDE/ATA 

interface
• 10Base/T-100/1.0 GB Base-TX Network 

Controller
• 2 PCI Slots (3 32b/33MHZ)
• 1 PCI-E x 16 slot
• 1 PCI-E x 1 slot (500 MHz)
• Microsoft Windows XP Professional operating 

system with SP2

LCD 1505FP DELL Ultra 
sharp 15-inch monitor with 
height adjustable stand

FreeFlow Scanner 665E supports the DELL Ultra 
sharp 15-inch flat-panel display.
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Powering on/off the system

The system consists of the scanner, the PC monitor, the and the 
PC workstation (hard drive tower, mouse, and keyboard).

Power on

Follow these steps when powering on the system.

1. Power on the scanner and wait for the green LED to light.

2. Power on the PC monitor.

3. Power on the workstation.

4. If required, log into the network.

NOTE: All FreeFlow software applications are found by selecting 
from the Windows task bar the following: Start: Programs: Xerox 
FreeFlow Software.

Power off

Follow these steps when powering off the system.

1. From the Windows tasteable select Start: Shut Down; the 
Shut Down Windows dialog box appears.

2. Select Shut Down from the What do you want the 
computer to do? drop-down list.

3. Select OK to shut down the PC and power off the 
workstation.

4. Power off the PC monitor.

5. Power off the scanner.
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RDO files

RDO is the three-letter extension for the Raster Document Object 
file type. As stated earlier, the RDO file type is used primarily with 
FreeFlow, but you can use RDOs with other FreeFlow 
applications, or convert them to PostScript or PDF files.
An RDO is a document file made up of images. An RDO has two 
parts:
• A PostScript wrapper which contains all the information about 

the structure and format of the pages in your document.
• A .CON directory that holds the TIFF, JPEG, PostScript, and 

Adobe PDF files that make up the pages of your document.
When you create an RDO, FreeFlow creates both of these parts 
automatically.

With an RDO you can: • Scan hardcopy documents to create electronic images to add 
pages to your RDO.

• Insert existing TIFF files, JPEG files, PostScript files, or Adobe 
PDF files into your RDO.

• Export RDO pages to other file formats such as TIFF, JPEG, 
PostScript, or Adobe PDF.

• Create headers or footers, add page numbers and logos, 
group pages into sections, or choose a paper size for your 
RDO. There are also many other setup and printing options.

• Put as many pages as you want in an RDO. However, the 
bigger your RDO is, the longer it will take you to open it.

KEY POINT: Do not move, copy, rename, or delete an RDO using 
Windows Explorer. If you do, the content (.CON) directory will not 
be included in the operation, and the RDO will be corrupted. Use 
the FreeFlow File Manager to perform these operations on RDO 
files.
NOTE: For descriptions of the other file types you can use with 
RDOs, use the online Help system.
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FreeFlow Help

The FreeFlow Scanner 665E online Help system is an excellent 
source of information about the features available and how to use 
them.

Accessing the Help system

You can access the online Help system in a number of ways. The 
easiest way is to use the Help menu.
Perform the following steps to access the Help system.

1. From any FreeFlow Scanner 665E application, select Help: 
and either Help Topics or Help. The Help dialog box 
displays with the Contents tab displays.
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2. Select the Index tab to display an alphabetical list of Help 
topics. As you enter text into the Type in the keyword to 
find text box, topics associated with the words you type 
display.

3. Select the Search tab to search the entire Help system for 
one or more specific keywords.

4. Type a word in the Type in the keyword to find text box; for 
example, type mode.
NOTE: You can type more than one keyword at a time in 
the Type in the keyword to find text box.

5. Click the List Topics button to display all Help topics that 
contain the word “mode.”
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6. Double-click on the Enhance Image settings topic in the 
Select Topics to display list box. The topic displays in the 
text window on the right.

NOTE: You can store any displayed Help topic as a 
Favorite. With the desired topic selected, click on the 
Favorites tab. Select Add to add the topic to your list of 
Favorites.

7. Select Close ( ) in the title bar to close the Help system 
and return to the FreeFlow application window.
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Using the Document Glass

Use the document glass under the following conditions:
• The document is old, fragile, or torn 
• The document stock is lighter than 13 lb. or heavier than 32# 

lb.
• The document is on coated stock, inkjet paper, photographic 

paper, or other rigid media
• The document is larger than 11.7 x 17 inches 
• The document is bound
NOTE: Scan fragile documents, photographs (printed on 
photographic stock), inkjet papers, and bound documents on the 
Document Glass.

Scanning a 1 or 2-sided document

To scan a 1 or 2-sided document:

1. Raise the document glass cover. 

2. Place the document on the document glass, registering it in 
the upper left corner.

3. Close the document glass cover. 

4. Make the desired selections from the Scan and Print 
application.
The Scan and Print application is discussed in Chapter 3 on 
page 3-1.

5. If desired, make additional selections from Advanced 
Scanning.
The Advanced Scanning application is discussed in Chapter 
4 on page 4-1.

NOTE: If scanning a 2-sided document, be sure to select the 
2-sided option from Scan and Print/Advanced Scanning.

6. When satisfied with settings, click Scan (from Scan and 
Print/Advanced Scanning). 

NOTE: If scanning a 2-sided document, turn the document 
over and repeat steps Step 4 through Step 6 for the second 
side.
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Scanning a bound document

To scan a bound document:

1. Raise the document feeder. 

2. Place the bound document on the Document Glass, 
registering it on the front center edge, as indicated by the 
icon on the document glass frame.

3. Lower the document feeder, being careful not to move the 
bound document out of registration. 

4. From Advanced Scanning, select Document glass-bound 
original from the Scan location drop-down list.
Refer to Chapter 4, “Original input” on page 4-15.

NOTE: The maximum page dimension for scanning a 
bound original is 9 x 12 inches. 

5. From Advanced Scanning choose the Right page, Left page, 
or Both pages radio button.

Refer to Chapter 4, “Original input” on page 4-15.

6. Make the desired selections from the Advanced Scanning 
and Scan and Print applications.
The Scan and Print application is discussed in Chapter 3 on 
page 3-1 and the Advanced Scanning application is 
discussed in Chapter 4 on page 4-1.

7. When satisfied with settings, click Scan (from Scan and 
Print/Advanced Scanning). 
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Using the ADF

The ADF enables you to scan 1-sided and 2-sided documents 
quickly, and returns them in a stack in the same order you placed 
them in the input tray. 
Use the ADF for rapid scanning of up to 100 pages. The ADF can 
feed pages from 5.5 x 6.5 in. (139.7 x 165.1 mm), long edge feed 
(LEF), to 11.7 x 17 in. (297.2 x 431.8 mm) of uncoated, bond 
paper stock from 13 lb. (49 gsm) to 32 lb. (120 gsm).
To use the ADF:

1. From Advanced Scanning, ensure that Document feeder is 
selected from the Scan Location drop-down list.
Refer to Chapter 4, “Original input” on page 4-15.

2. Place a document or stack of documents in the input tray 
face up, either in the short edge feed (SEF) direction or the 
long edge feed (LEF) direction.

3. Adjust the ADF side guides so they gently touch the edges 
of the paper. 
FreeFlow Scanner 665E Operator Manual1-22



1.  Overv iew
4. From Advanced Scanning, click the SEF/LEF toggle to 
specify how the document is loaded in the input tray.

Refer to Chapter 4, “Original input” on page 4-15.

5. Make the desired selections from the Advanced Scanning 
and Scan and Print applications.
The Scan and Print application is discussed in Chapter 3 on 
page 3-1 and the Advanced Scanning application is 
discussed in Chapter 4 on page 4-1.

6. When satisfied with settings, click Scan (from Scan and 
Print/Advanced Scanning). 

Indicates direction
the documents are
loaded in the ADF
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2. Production Printer Settings

Before you can print your scanned documents you must set up 
your printer or printers. This chapter provides step-by-step 
instructions for setting up, editing, and deleting a printer.

Opening the Production Printer Settings application

Select Start: Programs: Xerox FreeFlow Software: Printer 
Production Settings.
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KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

The Printer Production Settings dialog box opens:

NOTE: This chapter uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press 
and color server for your work environment.

Overview

The Printer Production Settings application allows you to:
• Add a printer
• Edit an existing printer
• Delete a printer
• Choose a specific printer from the list as your default printer
• Check the status of any listed printer
• Create a job ticket

Job Ticket information is discussed in Chapter 5 on page 5-1.
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Adding/editing a printer

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
When adding a printer, enter the information for your site specific 
color printer by using the following procedure. If your site specific 
color printer is not a DocuColor 8000, your options and results 
may vary from what appears in this procedure.
1. From the Printer Production Settings dialog box, select 

Add Printer. The Add Printer dialog box displays.

NOTE: The availability of the Convert PDF files to PS and 
Support legacy DocuSP check boxes depends on the 
printer you add or select.

2. Type your <site specific printer name> in the Printer name 
text box; refer to the example below:

3. Type your <site specific print server> in the Printer server 
text box; refer to the example below:
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4. Type your <site specific print queue> in the Print queue 
text box; refer to the example below:

NOTE: Type the appropriate information for your server and 
your print queue based on the server and the print queue at 
your site. 

5. From the Printer model: drop-down list, select DocuColor 
8000: or your site specific printer.

6. From the Print controller/server type: drop-down list, select 
your site specific print controller/server type.

7. To ensure that the connection to the printer is working, select 
Test Print; this sends a test print to the printer.
If you do not get a test print from the printer, return to Step 1 
and begin again. If you continue to have problems adding a 
printer, see your network or system administrator or 
assistance.

8. Select OK. This returns you to the Production Printer 
Settings dialog box.

9. Select Close. This closes the Production Printer Settings 
dialog box.
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Editing a printer

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
You can edit an existing printer from the Production Printer 
Settings application.

Select Edit Printer; the Edit Printer dialog box opens:

To edit an existing follow Steps 1-9 of “Adding/editing a printer” on 
page 2-3.
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Deleting a printer

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

1. From the Printer Production Settings dialog box, select the 
desired printer.

2. Select Delete Printer. A dialog box displays asking you if 
you want to delete the current printer.

3. Select Yes to delete the printer; select Cancel to keep the 
printer and cancel the delete process.

4. Select Close. This closes the Production Printer Settings 
dialog box.
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Setting a default printer

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

1. From the Printer Production Settings dialog box, select the 
desired printer that you want as the default printer.

2. Select Set as Default Printer. A check mark appears to the 
left of the selected printer, indicating that this is now your 
default printer.

3. Select Close. This closes the Production Printer Settings 
dialog box.
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Checking the printer status

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
KEY POINT: This button functions only when the scanner is 
connected to a DocuSP color server.

1. From the Printer Production Settings dialog box, select the 
desired printer.

2. Select Printer Status.

3. Select Close. This closes the Production Printer Settings 
dialog box.
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Creating a job ticket

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

1. From the Printer Production Settings dialog box, select 
Create a Job Ticket.

2. The Job Setup dialog box opens.
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3. Make your desired selections.
4. Select OK to save and close the Job Setup dialog box. This 

returns you to the Production Printer Settings dialog box.
KEY POINT:The Job Setup/Job Ticket features are discussed 
in more detail in Chapter 5 on page 5-1.

5. Select Close. This closes the Production Printer Settings 
dialog box.
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3. Scan and Print

The Scan and Print process simulates a copier. The scanner 
creates a temporary digital file with which it uses to complete the 
copy.

Input document information

Input document type

NOTE: Use the icon in the Scan and Print application to help you 
properly position the hardcopy document on the scanner.

If your hardcopy 
document is: Example Use this part of the 

scanner

A bound document Book, magazine, or 
stapled set of pages

Document glass

A single page Letter, form or 
statement

Single-sheet feeder 
or multi-sheet feeder

An unbound 
document with 
printing on 1 or 2 
sides

Article, presentation, 
or report

Multi-sheet feeder
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Determine the condition of the hardcopy

Always be aware of the condition of your hardcopy 
documents. The condition of the hardcopy document, or input 
document, determines how you scan a document or whether you 
must create a new original. If a hardcopy document is in good 
condition, you can use the multisheet or single-sheet feeder. If the 
hardcopy document is fragile or damaged, use the document 
glass for the most reliable scan.

Good condition: • No staples or clips
• Flat and smooth pages
• Cleanly punched holes

Fragile Condition: • Flattened creases or folds
• Excessive curling
• Slightly torn edges
• Coated or glossy stocks

Damaged Condition: • Rough or torn holes
• Stapled or clipped pages
• Heavy folds or wrinkles
• Very rough or smooth surface paper (e.g., FAX paper)
• Transparencies
• Paste-ups (hardcopy that has tape or glue holding images in 

place)
• Vellum
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Opening the Scan and Print application

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
From Start: Programs: select Xerox FreeFlow Software: and 
Scan and Print.
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Scan and print an original

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

Follow these steps when scanning an original.
1. With the Scan and Print application open, place the 

hardcopy document on the scanner glass or into the 
multisheet feeder.

2. From the Options section, select Print.

The Print option is discussed in more detail on page 3-14.

3. From the Scan section, make the desired selections for:

• Sides to scan
• Original page size of your document
• Mode (color or black and white)
• Image orientation
• Reduce/Enlarge
• Brightness

Scan
options

Enhance
options

Print
options

More Options
button

Advanced
Scanning button

Setup
button
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NOTE: By clicking on the Advanced Scanning... button, 
more options are available. This button is discussed in more 
detail on Chapter 4, “Advanced Scanning” on page 4-1.

Each one of these options is discussed in more detail later in 
this chapter or Chapter 4 on page 4-1

4. From the Enhance Image section, select either Deskew or 
Despeckle (black and white mode only).
• Deskew eliminates the skew of an image.
• Despeckle removes stray pixels that appear as “dirt” on 

an image.
Each one option is discussed in more detail on page 3-19.

5. From the Enhance Document section, select one or more of 
the following:
• Header to add a header
• Footer to add a footer
• Page numbers to add page numbers to your document
NOTE: By clicking on the Setup... button, more options are 
available. This button is discussed in on page 3-21.

Each one of these options is discussed in more detail starting 
on page 3-21.

6. From the Print section, make selections for:

• Printer
• Number of copies (and check Collated if appropriate)
• Job type
• Stock size and type (and check Drilled if appropriate)
• Number of sides imaged
• Output location
• Finishing options
• Account name or number, if desired.
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NOTE: By clicking on the More Options... button, a Job 
Setup dialog box opens with additional options. This button 
is discussed in more detail in Chapter 5 on page 5-1.

Each one of these options is discussed in more detail starting 
on page 3-24 and in Chapter 5 on page 5-1.

NOTE: To disable all additional options without having to 
change each one individually, clear the Apply More Options 
check box.

7. To activate the copy process, at the bottom of the Scan and 
Print dialog box, select Scan and Print.
NOTE: The green button on the scanner does not activate 
Scan and Print.

8. When you are finished, close the Scan and Print application.
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Scan and print a large job

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
You can use Scan and Print to build large copying jobs with the 
Scan to Job button. Large jobs are defined as those with page 
counts that exceed the capacity of the scanner’s multisheet 
feeder; refer to Chapter 10 on page 10-1 for the capacity of this 
scanner.

Follow these steps when scanning large jobs.
1. With the Scan and Print application open, place the first 

portion of your job into the multisheet feeder.
2. Select your job options; refer to Steps 2-8 of the “Scan and 

print an original” on page 3-4.
3. Select the Scan to Job button.
4. After the first portion of your job is scanned, place the second 

portion of your job into the multisheet feeder.
5. Repeat Steps 2-4 until your entire job is scanned.
6. Select Print Job; your job is submitted to the selected printer.
7. When you are finished, close the Scan and Print application.

Scan to Job
button
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Scan and save documents

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
You can scan a document and save it as an RDO or an Adobe 
PDF by using the Scan and Print application.

Follow these steps when scanning and saving documents.
1. With the Scan and Print application open, place the 

hardcopy document on the scanner glass or into the 
multisheet feeder.

2. From the Options section, select Save.

2. Save

becomes
active

1. Select a

option section
Save
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3. Select your job options; refer to Steps 3-8 of the “Scan and 
print an original” on page 3-4.
NOTE: Step 6 of the “Scan and print an original” on page 3-4 
discusses the Print options. For Save jobs, this section of 
the Scan and Print dialog box is called either Job Ticket 
Settings or PDF Options; refer to Step 8 of this 
procedure. The options for Job Ticket Settings are the 
same as the Print options. The PDF Options are not the 
same; refer to “Print/Job Ticket Settings/PDF Options” on 
page 3-24.

4. From the Save section, select either RDO or PDF.

The Display in Acrobat option is discussed in more detail on 
“Display in Acrobat” on page 3-18.

5. Select Browse; the Save As dialog box opens.

6. Use the Save in drop-down list to navigate to and select the 
desired Windows location to store the file.

7. Type the name of your file in the File name text box.
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8. Select PDF Files (*.pdf) or RDO Files (*.rdo) from the Save 
as type list box.
NOTE: When Save As: PDF is selected from the Save 
section, the Print section on the right side of the dialog box 
changes to PDF Options. When Save As: RDO is selected, 
this section changes to Job Ticket Settings. Refer to the 
illustration below.

9. Select Save or OK to close the Save As dialog box and 
return to Scan and Print. The path for your job displays in the 
Location box.

10. Select a printer from the Optimize for or the Printer drop-
down list.

11. Select any other appropriate options from this section.
12. Select Scan and Save. Your file is saved to the specified 

location.
13. When you are finished, close the Scan and Print application.

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

Save As: PDF
and PDF Options

Save As: RDO
and Job Ticket Settings
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Scan, print, and save documents

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
You can scan a document, print it, and save it as an RDO or an 
Adobe PDF by using the Scan and Print application.

Follow these steps when scanning, printing, and saving 
documents.
1. With the Scan and Print application open, place the 

hardcopy document on the scanner glass or into the 
multisheet feeder.

2. From the Options section, select Print and Save.
3. Select your job options; refer to Steps 3-8 of the “Scan and 

print an original” on page 3-4.
4. From the Save section, select either RDO or PDF.

The Display in Acrobat option is discussed in more detail on 
“Display in Acrobat” on page 3-18.

5. Select Browse; the Save As dialog box opens.
6. Use the Save in drop-down list to navigate to and select the 

desired Windows location to store the file.
7. Type the name of your file in the File name text box.
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8. Select PDF Files (*.pdf) or RDO Files (*.rdo) from the Save 
as type list box.

9. Select Save to close the Save As dialog box and return to 
Scan and Print. The path for your job displays in the Location 
box.

10. Click Save, Print & Save.
11. When you are finished, close the Scan and Print application.

Scan and Print features

This section discusses in detail the various Scan and Print 
features. The features are discussed in the order they are shown 
on the Scan and Print dialog box (refer to the illustration below):

NOTE: When the Scan and Print application is started, the Print 
option is the default selection.

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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Menus

The Scan and Print application has the following menus:

File: This menu contains:

• Save User Defaults: Allows you to save the current settings 
as the user defaults for Scan and Print. All user default 
settings are restored when Scan and Print is opened.
You can create user default settings to maintain your most 
frequently used feature settings between Scan and Print 
sessions. To create new user defaults, refer to “Creating new 
user defaults” on page 3-14 for the step-by-step instructions.

• Restore User Defaults: Returns all controls to the user 
default settings. 
– You can reset all feature settings to the previously defined 

user defaults at any time during your Scan and Print 
session. Resetting defaults is particularly helpful when 
scanning multiple documents with different properties (for 
example, size, plex, headers, and so forth); it allows you to 
quickly return all features to their default setting. 

– You can restore all user default settings by selecting File: 
Restore User Defaults.

• Restore Factory Defaults: Returns all controls to the factory 
default settings. 
– You can reset all feature settings to the factory defined 

defaults at any time during your Scan and Print session.
– To reset factory defaults, select File: Restore Factory 

Defaults.
• Exit: Allows you to exit from the Scan and Print application. 
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View: This menu contains:

• Printer/Job Status: Opens the Job Manager dialog box so 
you can manage the jobs in the print queues.

• Quick Print: Opens the Quick Print dialog box. 
• Inches: Select this option to change the measurement to 

inches. 
• Millimeters: Select this option to change the measurement to 

millimeters. 

Help: This menu contains:

• About Scan and Print: Displays version and copyright 
information for the Scan and Print application. 

• Help: Contains the commands for using and learning about 
the online Help system. 

Creating new user defaults

You can create user default settings to maintain your most 
frequently used feature settings.
1. Set all features to your desired default settings.
2. Select File: Save User Defaults.
3. Click OK to save the settings.

Options

This area of the Scan and Print dialog box allows you to choose 
from one of the following:
• Print: Select this option if you want only a printed output copy 

of your scanned document.
• Save: Select this option if you want to save your scanned 

document and do not want a printed output.
• Print and Save: Select this option if want both a printed 

output and saved file of your scanned document.
KEY POINT: The remainder of the options available on the Scan 
and Print dialog box will vary depending on the selection made 
here.
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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Scan

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

This area of the Scan and Print dialog box allows you to choose 
the following:
• Sides to scan: Based on your original documents, select one 

of the following:
– 1 Side: Select this option if your scan job consists of 1-

sided documents only.
– 2 Sides: Select this option if your scan job consists of 2-

sided documents.
• Original page size of your document: From the drop-down 

list select the size of your original document.
• Mode: Based on your original documents select one of the 

following:
– Color: If your original document is in color, select this 

option.
– Black and White: If your original document is in black and 

white, select this option.
KEY POINT: If Black and White is selected, the Enhance Image 
option activates for additional selections. The Enhance Image 
option is discussed in more detail in “Enhance Image” on page 3-
19.
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• Image orientation: This option allows you to rotate your 
original documents as you scan them; select one of the 
following:
– Standard: This option does not rotate your 

documents. The scanned image appears in exactly the 
same orientation as the document’s orientation on the 
document glass.

– Rotated: This option rotates the document 90° while 
scanning it. The scanned image is printed in this rotated 
orientation.

• Reduce/Enlarge: This option allows to reduce or enlarge the 
scanned image; select one of the following:
– Fit to output stock size: This option resizes the image 

during the scanning process in order to fit the selected 
stock size, while it still maintains the image's aspect 
ratio. If a standard job type is selected, the setting is 
mapped to the Scale to setting in the Xerox scanner 
TWAIN interface. If a non-standard job type is selected, 
the setting maps to the "Auto-fit" setting in the Job setup 
dialog box.

– Scale to: This option scales the image to a specific 
percentage that is entered by the user. The range of 
available percentages is displayed below the text 
field. This range is based on the width of the original page 
width setting.

• Brightness: This option adjusts image brightness. Specify a 
value by which to increase or decrease the overall light/dark 
setting of the image. To change the brightness level, use the 
slider or entering a number in the text box above the 
slider. Accepted values range from -10 to +10 (whole 
numbers only); +10 is the brightest.

• Advanced Settings: By clicking on this button, more Scan 
options are available for your selection. This button and its 
options are discussed in more detail in Chapter 4 on page 4-1.
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Save

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

KEY POINT: This area of the Scan and Print dialog box is active 
and available for use only if Save or Print and Save is selected. If 
the Print option is selected, this area of the dialog box is grayed 
out and not available for use.
You can save your scanned jobs either as a PDF or RDO file:
• PDF: When this radio button is selected, scanned jobs are 

saved in an Adobe PDF format. By checking the Display in 
Acrobat option, Adobe Acrobat/Reader opens and displays 
your scanned job.

• RDO: When this radio button is selected, scanned jobs are 
saved in a FreeFlow RDO format.

NOTE: The Display in Makeready function is not available 
and remains grayed out.

• Location: Select a location for storing your saved jobs by 
clicking on the Browse button and navigating to the desired 
location. Be sure to type the name of your file in the File 
name text box.

KEY POINT: You must select a Location for storing your saved 
scanned jobs. By system default, all scanned jobs are saved to 
C:\\Documents and Settings\Montego\Local Settings\Temp.
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Display in Acrobat

Check the Display in Acrobat check box, and select one of these 
buttons:
• Scan and Save or
• Scan to Job and then Save Job or
• Scan, Print and Save or
• Scan to Job and then Print and Save Job
Your document is scanned. Upon completion of the scan 
operation, Adobe Acrobat opens and displays your scanned 
document.
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Enhance Image

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

KEY POINT: The Enhance Image option activates only when the 
Black and White scan option is selected. It is not available for 
color scan jobs.
The Enhance Image area provides Deskew and Despeckle 
options when scanning black and white images:
• Deskew: This option straightens a crooked image. Deskew 

checks your scanned files for any skew, or tilt, and corrects the 
skew by tilting the bits within the image boundary.
– Skew most commonly occurs during scanning. The 

Deskew option checks for skew every tenth of a degree 
starting from .10° to a maximum of 20°.

– Deskew does not operate with a skew of less then 1/10 of a 
degree or more than 20°. 

– To enable this option, select the Deskew checkbox.
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• Despeckle: This option removes specks from the scanned 
image. The Despeckle feature locates and removes any 
background spots, or specks, that may occur on your scanned 
image.
– The size you set for the Despeckle option refers to the 

maximum speckle size that will be removed from the 
image. For example, if the speckle size is set to 10, then 
ten refers to a 10 X 10 square pixel; any speckle this size 
or smaller is removed from the image. 

– To enable this option, check the Despeckle checkbox.
– Drag the slider or type a value in the associated text 

box to indicate the size (in pixels) of the speckles to 
remove. Accepted values are from 1 to 30 pixels. The 
default is 1.

– To protect a halftone image from the despeckle 
process, check the Protect halftones checkbox. A 
check mark indicates that the halftone will not be 
despeckled.
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Enhance Document

This area of the Scan and Print dialog box provides options for 
adding headers, footers, or page numbers to scanned pages.
To add headers, footers, page numbers or a combination of these 
options, use the following procedure.
1. To enable one or more of these options, simply click on the 

checkbox to the left of the desired option.

2. Select the Setup button; the Header/Footer/Page Numbers 
dialog box displays:

To add a Header or Footer, click on the desired tab.

3. Enter the desired text for your header/footer by typing inside 
the Text area.

NOTE: The Preview section at the bottom of the this dialog box 
displays the text as you type it in the text box. This gives you a 
preview what the text will look like on your page.
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4. Make any other desired selections for your header or footer:

• Position: Select where on the output copy that you want 
your header/footer printed. Choose one of the following 
Left, Center, Right, and then select either Top or 
Bottom.
– Left: The header/footer is positioned in relation to the 

left edge of the page. Enter the distance from the 
horizontal edge of the page by typing a number in the 
text box or using the up/down arrows located on the 
right on the right side of the text box. 

– Right: The header/footer is positioned in relation to 
the right edge of the page. Enter the distance from 
the horizontal edge of the page by typing a number in 
the text box or using the up/down arrows located on 
the right on the right side of the text box. 

– Centered: The header/footer is centered between 
the right and left edge of the paper. 

– Top: The header/footer is positioned in relation the 
top edge of the page. Enter the distance from the 
vertical edge of the page by typing a number in the 
text box or using the up/down arrows located on the 
right side of the text box.

– Bottom: The header/footer is positioned in relation 
the bottom edge of the page. Enter the distance from 
the vertical edge of the page by typing a number in 
the text box or using the up/down arrows located on 
the right side of the text box.
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• Font: Select the desired font, font size, font style, and 
font color that will be used when printing the header/
footer. Select the font name, size, style, and color from 
their respective drop-down list.

• Background: Select either Opaque or Transparent.
– Depending on the vertical/horizontal position of the 

header/footer, selecting Opaque may print the 
header/footer over the scanned text/pictures. This 
may cause some of the scanned information to be 
unreadable.

– Selecting Transparent will print the header/footer as 
a watermark image on the output. Any text/pictures/
information on the scanned page will be readable.

5. Click the Apply button.
6. Repeat Steps 1-5 as required for the Page Numbers.

• You can enter a Prefix and/or Suffix for your page 
numbers by typing inside the Prefix/Suffix text box.

7. Click the OK button to save and close this dialog box.
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Print/Job Ticket Settings/PDF Options

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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KEY POINT: The features available on this area of the Scan and 
Print dialog box may vary depending on the Option selected 
(Print, Save, or Print and Save). Refer to the following 
illustration:

NOTE: The options that are available for the various Print/Job 
Ticket Settings and PDF Options may vary with each digital 
press system. The options discussed in this book may or may not 
be available with your system.

When the Print or Print and Save option is selected, the Scan 
and Print dialog box displays the various features that are 
available for printing your scanned document.
• Printer: From the drop-down list select the desired printer.

NOTE: If the desired printer is not shown in the drop-down 
list, you will need to add the printer. This is discussed in 
details in Chapter 2 on page 2-1.

• Copies: Enter the number of desired output copies by typing 
inside the text box or by using the up/down arrows located on 
the right side of the text box.
If more than output copy is entered, the Collated option 
activates. Check the Collated box if you want your output 
copies collated; uncheck, or clear the check box, if you do not 
want collated copies.

If the Print or 
Print and Save 
Option is selected,
then these features
are activated:

If the Save and
Save As: PDF
options are selected,
then these features
are activated:

If the Save and
Save As: RDO
options are selected,
then these features
are activated:
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• Job type: Select the desired job type from the drop-down 
list. The various job types are discussed in more detail in 
Chapter 5 on page 5-1.

• Stock size: Select the desired output size from the drop-
down list. The various stock sizes are discussed in more detail 
in Chapter 5 on page 5-1.

NOTE: The remainder of these features are not available when 
Save: Save As: PDF is selected.

• Stock type: Select the desired output stock type from the 
drop-down list. The various stock types are discussed in more 
detail in Chapter 5 on page 5-1.
The Drilled option is activated only if that paper stock is 
loaded in one of the paper trays; otherwise, this option is 
grayed out and unavailable for selection.

• Sides imaged: From the drop-down list, select 1 Sided, 2 
Sided, or (2 Sided) Head to Toe.

• Output: From the drop-down list, select the location where 
the printed output is sent. The available selections will vary 
depending on the finishing devices connected to your system.

• Finishing: Depending on the selected output device, there 
may be finishing options available, such as stapling. The 
selection made here depends on the selection made for 
Output.

• More Options: Click this button to open the Job Setup dialog 
box. This dialog box and its options are discussed in more 
detail in Chapter 5 on page 5-1.
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Scan and Print main buttons

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
Along the bottom of the Scan and Print dialog box are the 
application’s main buttons.

Scan and Print
main buttons
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Two of these buttons and their functions change according to the 
feature selected in the Options area of the dialog box. The other 
three buttons never change and always retain the same function; 
refer to the illustration below:

Print Option Uses these buttons

Save Option Uses these buttons

Save Option Uses these buttons

These buttons always remain the same
regardless of the Option selected.
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Restore Defaults button

Clicking this button restores the Scan and Print settings to their 
default settings.
NOTE: The default settings that are restored are your user 
defined defaults. If you want to restore the factory defaults, you 
must select File: Restore Factory Defaults.
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4. Advanced Scanning

The Advanced Scanning feature is accessed from the Scan and 
Print window. This chapter discusses the various Advanced 
Scanning features.

Accessing Advanced Scanning

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
By clicking on the Advanced Scanning button from the Scan and 
Print window, the FreeFlow Scanner 665E dialog box opens and 
provides more scanning options.
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Using the Automatic Document Feeder and Advanced Scanning

The Automatic Document feeder on the scanner will enable you to 
scan 1 and 2-sided documents quickly, and returns them in a stack 
in the same order you placed them in the input tray.
To use the Automatic Document feeder:
1. Ensure Document feeder is chosen in the Scan Location 

drop-down list located on the Basic Features tab.
2. Place a document or stack of documents in the input tray 

face up, either SEF or LEF.
NOTE: If ultimately outputting to print, verify that your printer 
can print either SEF or LEF. If it can only print one way, make 
sure the image is scanned accordingly.

3. Adjust the side guides so they gently touch the edges of the 
paper.

4. Click the SEF/LEF toggle to specify how the document is 
loaded in the input tray.

5. Make all other input and image quality settings.
6. Click Preview to verify settings.
7. When satisfied with settings reload the documents and click 

Scan.
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Scanner software overview

The FreeFlow Scanner 665E software is also known as Xerox 
Scanner software. The scanner software is comprised of two 
components:

TWAIN Scanning
Application

This component is also called TWAIN Data Source or TWAIN 
driver and is used for scanning.
NOTE: TWAIN is a scanning specification which allows 
programmers to write scanner software modules (like the 
FreeFlow scanning application) that work with any TWAIN-
compliant application, such as Photoshop or Paintshop Pro. This 
means that you can use your Xerox Scanner with any imaging 
application that supports the TWAIN standard.

Scanner Support This component is used for maintenance and troubleshooting.
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Main scanning features

There are three main parts to the TWAIN Scanning software 
interface. At the top of the screen are the control menus. Below 
these are the settings tabs and the scanning controls. On the right 
side of the interface is the Preview window; refer to the illustration 
below:

Control menus

Settings
tabs and
scanning
controls

Preview window
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Control menus

There are four menus at the top of the scanner dialog box:

File Use the File menu to save new scan tickets, save changes to 
existing scan tickets, and as a way to exit the scanner 
software. Refer to the “File menu” on page 4-5 for more details on 
this menu.

View Use the View menu to select which controls are visible, and to 
select image viewing size. This is discussed in more detail on 
“View menu” on page 4-6.

Options Use the Options menu to set preferences and calibrate the 
scanner. This is discussed in more detail on “Options menu” on 
page 4-7.

Help Use the Help menu to access Help, Troubleshooting, and other 
information about the scanner. This is discussed in more detail on 
“Help menu” on page 4-12.

File menu

Use the File menu to save new scan tickets, save changes to 
existing scan tickets, and as a way to exit the scanner software.

NOTE: The File menu can be accessed from the keyboard by 
pressing ALT, F.

The File menu contains the following controls:

Save Scan Ticket Select Save Scan Ticket to save changes you may make to an 
existing scan ticket.

Save Scan Ticket As Select Save Scan Ticket As to save a new set of control 
selections or to save the current set as a different name.

Scan All Select Scan All to scan your document.

Preview Select Preview to see what effect your scan settings will have 
before doing an actual scan, or to use as a visual guide for setting 
Crop or Frame boundaries; both these options are discussed in 
more detail on “Preview window” on page 4-34.
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Skip Select Skip to discard the current preview image. This button is 
enabled when the Document feeder and Single page mode 
options are selected; this is discussed in more detail on “Single 
Page Mode” on page 4-11.

Exit Select Exit to close the scanner window. At this point, all scanned 
files are returned to the imaging application (such as PhotoShop, 
Adobe Capture, etc.). Any scan tickets that are in use when Exit 
is selected will not be saved; therefore, remember to save before 
closing the scanner window.

View menu

Use the View menu to select which controls are visible, and to 
select image viewing size.

NOTE: The View menu can be accessed from the keyboard by 
pressing ALT, M.

The View menu contains the following controls:

Zoom Select Zoom to zoom in and out of a scanned document. You can 
use the Zoom In and Zoom Out controls to change zoom levels in 
25% increments. Select Whole Page to fit your scanned 
document in space available, or select any percentage value 
between 50% and 200%.

Show Rulers This control is checked by default. When checked, a ruler is 
shown on the left and top edges of the Preview window. By using 
the Localize tab (from the Options drop-down list), the ruler can be 
set to either inches, pixels, millimeters, or centimeters.

Rulers
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Status Bar This control is checked by default.

When checked, the Status Bar displays the following information: 
• Condition of scanner 
• Total pages scanned during a job 
• Original document size 
• Output document size (Image size) 
• File size 

Show Preview This control is checked by default. When checked, the Preview 
window is visible. When unchecked, only the tabbed dialog is 
visible.

Options menu

Use the Options menu to set preferences and calibrate the 
scanner.

NOTE: The Options menu can be accessed from the keyboard by 
pressing ALT, O.

The Options menu contains the following controls:

Status bar (at the bottom of the scanner window)
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Preferences

Select Preferences to see a tabbed dialog with the following tabs:

General

Use the controls on this tab to specify default settings for common 
original documents.

File Transfer Mode
Settings:

– Rotate Image: This option causes the scanner to 
rearrange the data in the output image so that the image 
will appear upright when viewed.

– Use TIFF Orientation Tag Only: TIFF images contain a 
bit of information called an orientation tag. This tag tells 
imaging applications how to display the file. This option 
allows faster scanning than the Rotate Image option.

Mask Page Edge: This control is checked by default. When checked, this feature 
applies a 0.12 inch (3mm) mask to the image area perimeter, 
preventing dark lines or shadows from appearing on the edges of 
the image. If you need additional edge cleanup, it should be done 
using the Crop or Frame features; refer to “Crop” on page 4-24 
and on “Frame” on page 4-28.

Default Scan Ticket: This list box contains all of the scan tickets found in the Scan 
Ticket list box on the Basic Features tab. Use the list box in 
the Preferences dialog to choose which scan ticket will be set 
as the default.
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Localize

Use the controls on this tab to set language and measurement 
defaults.

Language: Use the Language list box to control what language text and 
numerals will be displayed in the scanner window.
NOTE: The supported languages are English, French, Italian, 
German, Spanish, Dutch, and Brazilian Portuguese.

Units: Inches is set as the default unit of measure. Use the Units list box 
to control which unit of measure is used by the scanner. 

Page size list: Show US paper sizes at the top is selected by default. Choose 
one of these radio buttons to control which set of paper sizes; US 
or ISO, is shown at the top of the input paper size drop-down 
menu list.
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Compression

Use the controls on this tab to set compression defaults.

Production Color (24-bit)
compression controls:

The controls within this group box define the compression setting 
when "Production Color (24-bit)" is the selected color mode.

JPEG Compression Level
slider:

Use this slider to select from ten levels of JPEG 
compression. The default for this slider is nine, which is a good 
compromise between decent image quality and manageable file 
size. The higher the compression setting, the smaller the file size 
and the worse the image quality. 

Black and white (1-bit)
compression controls:

The controls within this group box define the compression setting 
when Black and White is the selected image mode. 
• None: Select this radio button to disable compression while in 

the Black and White image mode.
• CCITT Group 4: This button is checked by default. When 

selected, CCITT Group 4 compression is enabled while in the 
Black and White image mode.
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Calibrate Scanner

Calibrate the scanner whenever you notice a degradation in image 
quality or consistency.

Scanner calibration may be done any time the scanner is not in a 
"busy" state. This is discussed in more detail in the System 
Administration Guide, chapter 4. Hardware maintenance, 
“Calibrate Scanner” on page 4-12.

Fast Preview

The Fast Preview feature is activated and deactivated by clicking 
the item on the Options menu. When active, a checkmark 
appears next to the feature name.
Fast Preview samples the image at a lower resolution than your 
chosen print resolution. This is sufficient for setting Crop and 
Frame margins. However, for adjusting Image Quality settings, 
you should first deactivate the Fast Preview feature. The Preview 
window will then display your image at the actual print resolution.

Single Page Mode

Enable Single Page Mode: This option is available only when scanning black and white 
documents and the Document feeder is selected.

Automatically Preview Next
Image:

When using the document feeder in the single page mode, this 
feature automatically feeds and displays a preview of the next 
page in a stack whenever the Next or Skip buttons are pressed 
for the current image.
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Help menu

Use the Help menu to access Help, Troubleshooting, and other 
information about the scanner.

NOTE: The Help menu can be accessed from the keyboard by 
pressing ALT, H.

The Help menu contains the following controls:

Contents Select Contents to launch online Help. You will be at the top level 
(or the front page) of the Help system, and can navigate via the 
Table of Contents, the Index, or the Search function.

Troubleshooting Select Troubleshooting if you are having problems with image 
quality, communications, or paper jams, and go directly to a 
problem solving section of the online Help.

Getting Started Select Getting Started for an introduction to the Xerox Scanner 
hardware and software.

Hints and Tips Select Hints and Tips to learn about suggested practices to help 
you work more quickly and efficiently.
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Settings tabs

Click on the tabs to access basic features, image quality, and 
image size settings.

Basic Features

Think of the Basic Features tab as the main control panel for the 
scanner. Use the Basic Features tab to describe your document’s 
features to the scanner (the input parameters), and to set 
resolution and image mode (output parameters). Unless your 
original needs to be resized or requires image quality adjustments, 
you can set up the whole scan job from this tab.

Scan ticket

The top section has controls for creating and selecting scan 
tickets. Scan tickets are a powerful time saving feature that allow 
you set up a job with a single mouse click. They allow you to store 
all the settings for common or complex scan jobs (including Image 
Quality Windows and Custom Page Sizes) so that you can quickly 
reload the settings instead of manually reprogramming the scan 
job.
Scan tickets include:
• Using an existing scan ticket (refer to page 4-14)
• Creating a new scan ticket (refer to page 4-14)
• Backing up a scan ticket file (refer to page 4-15)
• Deleting a scan ticket (refer to page 4-15)
NOTE: Scan tickets saved in one scanning application may not be 
available in other scanning applications.
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To use an existing scan ticket, follow this procedure:
1. Click on the Scan ticket drop-down list on the Basic Features 

tab.

2. Click on the name of the ticket you wish to use.

NOTE: The selection for Single Page Mode is not saved in 
any Scan Tickets. If you select a scan ticket and you wish to 
scan one page at a time you must manually select the Single 
Page Mode checkbox.

To create a scan ticket, use the following procedure:
1. Adjust the settings for your scan job. 

a. Adjust the input document settings (page size, number of 
sides, scan location). 

b. Select an Original Type. 
c. Select an Image mode. 
d. Select a Resolution. 
e. Select a target printer for optimization. 
f. Adjust Image Size and Image Quality settings as needed. 

2. Click the Save Scan Ticket As button.
3. Enter a name for the scan ticket and click Save. 
FreeFlow Scanner 665E Operator Manual4-14



4. Advanced Scanning
To back up a scan ticket file, use the following procedure:

NOTE: Making backup copies of your Scan Tickets is essential. 
This is the only way to prevent another operator from overwriting 
or deleting your saved settings. 

1. Place a formatted floppy disk in drive A: 
2. Right click the Start button. 
3. Select Explore. 
4. Browse to C:\Program Files\Common Files\Xerox\ 

Scanner. 
5. Select all the files with the ".sct" extension; right-click and 

select Send To: 3½ Floppy (A]. 
To delete a scan ticket, use the following procedure:
1. Select the ticket to be deleted from the drop-down list on the 

Basic Features tab. 

2. Click the Delete button.
3. Click OK to confirm. 

Original input

Select the various options that define the original document being 
scanned.
• Scan location: Choose from where you will scan your 

original: the Automatic Document feeder, the Document glass, 
the Document glass - bound original, or Automatic selection.

• Original size: Select a size from this drop-down list or select 
Custom page size... to create a new page size.
US paper sizes appear before ISO paper sizes by default. To 
change the order in which page sizes are listed, select 
Options: Preferences and go to the Localize tab.

• 2 sided: Select the 2 sided checkbox to scan two-sided 
originals.

• Feed orientation: Click the Page Feed Orientation button to 
change the page feed direction. You can choose either LEF or 
SEF. The choice depends primarily on your printer. If it feeds 
paper LEF, then you should scan LEF. If your printer feeds 
SEF, then scan SEF. For fastest throughput, scan LEF.
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• Image orientation: Click the Image Orientation button to 
choose between portrait and landscape originals.

• Original type: Select an original type that best describes your 
original document. Each Original Type has been programmed 
to give the best results for the kind of original it describes. 
NOTE: The Automatic type is only available for some printers.

KEY POINT: If you are scanning a batch of originals of mixed 
type, scan the pages in Single Page Mode, adjusting the 
Original Type for each page as needed before scanning.
Refer to the table in Chapter 9, “Guide to choosing an Original 
Type for your scan” on page 9-2 for guidance on choosing the 
best Original Type for your documents.

• Media type: Media Types are used for color scanning. They 
identify the printing process used to create the original, so that 
the scanner can make proper corrections for accurate color 
reproduction.
KEY POINT:This feature is only available in Production Color 
mode. The Media type drop-down list is found on the Basic 
Features tab and the Image Quality Windows dialog.
Choose an item from this list that best describes the printing 
process used to create your original document. This selection 
affects how closely the scanner reproduces the color in your 
original image.
Refer to the table in Chapter 9, “Guide to choosing a Media 
Type” on page 9-3 for guidance on choosing the best Media 
Type for your documents.
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Output image

From the Output image area, select the image mode, resolution, 
and optimization (if necessary).

Image Mode

KEY POINT: For the FreeFlow Scanner 665E there are only two 
image modes available: Production Color and Black & White (1 
bit). The Image Mode selection is based on the Mode (Color/
Black and White) selection made from the main Scan and Print 
window.
The image mode relates to the type of original being scanned, as 
well as the scanned image's eventual output. For example: To 
scan an office memo with black text on plain white paper, choose 
Black and White for the Mode option (Scan and Print main 
window). When you select Advanced Scanning, the Output image 
mode is automatically Black and white (1 bit).
Another example is scanning a color photograph: From the main 
Scan and Print dialog, select Color for the Mode option. Select 
Advanced Scanning; the Output image mode is automatically 
Production Color.
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Resolution

From the drop-down list, select the best scan/output resolution for 
your document.
To understand resolution better and to choose the best resolution 
for your printed output, refer to Chapter 9, “Understanding 
Resolution” on page 9-3 for more information about Resolution 
and what it means.

Optimize image for

Select the printer on which you will print your scanned image.
KEY POINT: For FreeFlow Scanner 665E, this option is grayed 
out and not selectable if you have selected Color as your Scan: 
Mode option. If you have selected as your Scan: Mode option 
Black and White, then this option is selectable, and you can 
choose from the drop-down list.

Image modes supported by the FreeFlow Scanner 665E for 
DocuColor 8000/7000 Digital Presses

Image mode Output

Black and white Images composed of black and white pixels only. 
No color or shading. (Appearance of shading 
achieved by controlling the density of the black 
pixels.) Images have the lowest bit depth (1 bit) 
and the smallest file size. Fastest scan speed 
achieved in this mode.

Production Color Images composed of up to 16.7 million colors 
(true color) in a device-independent 24-bits-per-
pixel color space. Files are output as either 
JPEG (compressed) or TIFF Technical Note 2 
(uncompressed).

Production Color images when printed or viewed 
on a computer screen will match very closely the 
colors in the original image.
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Choosing a Printer for
Optimization

Every printer has different capabilities and methods for 
reproducing shading in black and white images. To get optimum 
results, your image has to be adjusted slightly for the target 
printer. Choose the printer to which the image will be sent for 
production printing.
To select a target printer:
1. Click on the Basic Features tab.
2. Click on the Optimize image for: dropdown list.
3. Select the target printer from the list.

If your specific printer is not listed, choose a generic type 
and use the Advanced Image Quality controls to get 
optimum results. 

Image Quality

Use the Image Quality tab to make basic adjustments to the 
quality of your scanned image, such as brightness, contrast, 
sharpness, and background suppression. Also, access the 
Advanced Image Quality controls from this tab.
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Original type

Choose the preset original type that best describes your 
document. These presets are designed to give good image 
quality for most documents of the types listed.
For help on choosing an original type, refer to Chapter 9, “Guide to 
choosing an Original Type for your scan” on page 9-2.

Image adjustments

Brightness Use the Brightness control to adjust the lightness or darkness of 
the image. The Brightness slider affects the whole image, but will 
affect midtones to a greater extent than shadows or highlights. For 
finer control, use the Advanced Image Quality controls. Changes 
you make can be seen using the Preview feature.
For more information, refer to the Online Help (Advanced 
Scanning/Image Quality Tab, Image Adjustment controls).

Contrast Use the Contrast control to increase or decrease the contrast of 
the image. The Contrast slider affects the whole image. Increasing 
contrast tends to move midtone gray values toward black or white, 
making gray objects more distinct. Decreasing contrast tends to 
make shadows and highlights more gray, making objects less 
distinct. Changes you make can be seen using the Preview 
feature.
For more information, refer to the Online Help (Advanced 
Scanning/Image Quality Tab, Image Adjustment controls).

NOTE: The Contrast feature is disabled when the Text and Line 
Art Original Type is selected.
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Fine Adjustments Click the Fine Adjustments button to launch the Advanced Image 
Adjustments dialog. The Advanced Image Adjustments dialog 
allows fine control over highlights, midtones, and shadows within a 
scanned image.

NOTE: The Advanced Image Adjustments features are disabled 
when the Text and Line Art Original Type is selected.

For more information, refer to the Online Help (Advanced 
Scanning/Image Quality Tab/Fine Adjustments button; click Help).
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Sharpen Use the Sharpen feature to increase contrasts along the edges of 
objects in the image. This has the effect of making objects more 
distinct. Changes you make can be seen using the Preview 
feature.

Background suppression This feature is used to force the image background to white. Too 
much suppression can affect the highlights in an image, and is not 
recommended for full page photographs.

Negative image Selecting this checkbox reverses image content, making white 
areas black and black areas white.

Hole fill Selecting this check box removes the marks caused by the 
shadows of punched holes in your originals.
For more information on each one of these features, refer to the 
Online Help (Advanced Scanning/Image Quality Tab/
Enhancement controls).

More button The More... button launches a dialog that allows you to choose 
various rendering options for black and white images.

For more information on each one of these features, refer to the 
Online Help (Advanced Scanning/Image Quality Tab/More button).
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Image Quality windows This button opens the Image Quality Windows dialog, which lets 
you manually segment the image into different original types, each 
with unique image quality adjustments.

For more information on each one of these features, refer to the 
Online Help (Advanced Scanning/Image Quality Tab/Image 
Quality windows button).

Image Size

Use the tools on the Image Size tab to eliminate unwanted 
portions of the image or to reduce or enlarge the output 
image. The Image Size tab tools allow you to adjust the size of 
your scan by cropping, framing, or reducing/enlarging. Use the 
frame feature to mask hole punch marks, gutter and edge 
shadows. Use the crop feature to delete unwanted portions of the 
image (thereby making the image smaller).
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Crop

The Crop tool deletes the portion of the image outside the 
bounding box. By deleting the portion outside the bounding box, 
you are reducing the size of the file in bytes.

Cropping the Image Use the Crop feature to delete unwanted portions of the image. 
Using this feature changes the physical dimensions of the image; 
this means that the output image will be smaller than the original. 
To preserve the original dimensions, use the Frame feature 
instead.
NOTE: By default, the Mask Page Edge feature is active. 
However, if you select Crop or Mask on the Image Size tab, the 
Mask Page Edge feature is disabled.
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Cropping 1-sided documents

To crop 1-sided documents, use the following procedure:
1. Place the 1-sided document into the scanner, either on the 

document glass or in the document feeder, and enter all 
relevant input values on the Basic tab.

2. Click the Image Size tab.
3. Click the Preview button.
4. Select the Crop/Frame checkbox.
5. Click the Crop radio button.
6. In the Preview window, drag the bounding box until the area 

you want to delete is outside the bounding box.
7. If satisfied with the adjustments, click Scan.

Cropping 2-sided documents

To crop 2-sided documents, use the following procedure:
1. Place the 2-sided document into the scanner, either on the 

document glass or in the document feeder, and enter all 
relevant input values on the Basic tab.

2. Click the Image Size tab.
3. Click the Preview button.
4. Select the Crop/Frame checkbox.
5. Click the Crop radio button.
6. Select the Side A toggle (if scanning from the Document 

Feeder), or select the Side A radio button (if scanning from 
the Document Glass) and drag the sizing handles until the 
area you want to delete is outside the bounding box.

7. If scanning from the Document Glass, click Scan.
8. Repeat steps 6 and 7 for side B.
9. If satisfied with the adjustments, and have previewed from 

the Document Feeder, click Scan.
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Cropping bound, head to toe documents

To crop 2-sided documents, use the following procedure:
1. On the Basic Features tab, choose Document glass-bound 

original.
2. Place the original on the document glass as shown by the 

icon.

3. Choose the input document original size (this is the 
dimension of one page).

4. If only scanning one page, choose the top or bottom radio 
button. If scanning both pages, choose the Both pages 
radio button.

5. Make all other adjustments on the Basic Features tab.
6. Click Preview.
7. On the Image Size tab, select the Crop/Frame checkbox and 

the Mirror side 2 checkbox.
8. Make adjustments to the bounding box on one of the pages.

NOTE: Because Mirror side 2 is selected, any changes you 
make to one page will be duplicated as a mirror image on the 
second page.

9. Click Preview to review your settings.
10. If satisfied with settings, click Scan.
FreeFlow Scanner 665E Operator Manual4-26



4. Advanced Scanning
Cropping bound documents

To crop bound documents, use the following procedure:
1. On the Basic Features tab, choose Document glass-bound 

original.
2. Place the original on the document glass as shown by the 

icon.

3. Choose the input document original size (this is the 
dimension of one page).

4. If only scanning one page, choose the right or left radio 
button. If scanning both pages, choose the Both pages 
radio button.
NOTE: If Both pages was selected, notice that the A/B 
toggle button appears at the top of the Preview pane.

5. Make all other adjustments on the Basic Features tab.
6. Click Preview.
7. On the Image Size tab, select the Crop/Frame checkbox and 

if the Both pages radio button was selected, the Mirror side 
2 checkbox.
NOTE: If Mirror side 2 is selected, any changes you make 
to one page will be duplicated as a mirror image on the 
second page.

8. Make adjustments to the bounding box on one of the pages.
9. Click Preview to review your settings.
10. If satisfied with settings, click Scan.
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Frame

Use the Frame feature to fill the outer edges of the image with 
white. Using the Frame tool yields an image of the same physical 
dimensions as the original document (assuming you have not 
reduced or enlarged).
The Frame feature retains the physical dimensions of the image: 
the output image will be the same size as the original. To make 
the output image dimensions smaller than the original, use the 
Crop feature.

Masking the page edge

By default, the Mask Page Edge feature is active. However, if you 
select Crop or Mask on the Image Size tab, the Mask Page Edge 
feature is disabled.
To use the Mask Page Edge feature:
1. Select Options: Preferences.
2. Click on the General tab.
3. Select the Mask page edge checkbox on the General tab. A 

checkmark appears in the checkbox, indicating it is enabled.
4. Click OK to close the Preferences dialog.

NOTE: The Mask Page Edge feature applies a 3 millimeter 
white mask to the image area perimeter, covering any 
shadow caused by the edge of the page. For all other image 
imperfections beyond the 3 millimeter mask, use the Crop/
Frame controls and the bounding box in the Preview pane.
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Framing 1-sided documents

To Frame 1-sided documents:
1. Place the 1-sided document into the scanner, either on the 

document glass or in the document feeder, and adjust 
settings as needed on the Basic Features tab.

2. Click the Image Size tab.
3. Click the Preview button.
4. Select the Crop/Frame checkbox.
5. Click the Frame radio button.
6. In the Preview window, use the mouse to drag the bounding 

box until the area you want to delete is outside the bounding 
box. 

7. Click Preview again to verify your adjustments.
8. If satisfied with the adjustments, click Scan.

Framing 2-sided documents

To Frame 2-sided documents:
1. Place the 2-sided document into the scanner, either on the 

document glass or in the document feeder, and adjust 
settings as needed on the Basic Features tab.

2. Select the 2-sided checkbox.
3. Click the Image Size tab.
4. Click the Preview button.
5. Select the Crop/Frame checkbox.
6. Click the Frame radio button.
7. Adjust the bounding box until the area you want to frame is 

outside the bounding box. 
8. If satisfied with the adjustments, click Scan.
9. If using the Document Feeder, click B on the A/B toggle at 

the top of the Preview pane. If scanning from the Document 
Glass, click the [Back side] radio button.

10. Click the Preview button.
11. Adjust the bounding box until the area you want to frame is 

outside the bounding box.
12. If satisfied with the adjustments, click Scan.
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Framing bound, head to toe documents

To Frame bound, head-to-toe documents:
1. On the Basic Features tab, choose Document glass-bound 

original.
2. Place the original on the document glass as shown by the 

icon.

3. Choose the input document original size (this is the 
dimension of one page).

4. If only scanning one page, choose the top or bottom radio 
button. If scanning both pages, choose the Both pages 
radio button.

5. Make all other adjustments on the Basic Features tab.
6. Click Preview.
7. On the Image Size tab, select the Crop/Frame checkbox and 

the Mirror side 2 checkbox.
8. Make adjustments to the bounding box on one of the pages.

NOTE: Because Mirror side 2 is selected, any changes you 
make to one page will be duplicated as a mirror image on the 
second page.

9. Click Preview to review your settings.
10. If satisfied with settings, click Scan.
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Framing bound documents

To Frame bound documents:
1. On the Basic Features tab, choose Document glass-bound 

original.
2. Place the original on the document glass as shown by the 

icon.

3. Choose the input document original size (this is the 
dimension of one page).

4. If only scanning one page, choose the right or left radio 
button. If scanning both pages, choose the Both pages 
radio button.
NOTE: If Both pages was selected, notice that the A/B 
toggle button appears at the top of the Preview pane.

5. Make all other adjustments on the Basic Features tab.
6. Click Preview.
7. On the Image Size tab, select the Crop/Frame checkbox and 

if the Both pages radio button was selected, the Mirror side 
2 checkbox.
NOTE: If Mirror side 2 is selected, any changes you make 
to one page will be duplicated as a mirror image on the 
second page.

8. Make adjustments to the bounding box on one of the pages.
9. Click Preview to review your settings.
10. If satisfied with settings, click Scan.
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Removing hole punch marks 

To remove hole punch marks:

NOTE: Use this procedure if the Hole Fill feature does not give 
satisfactory results.

1. Place the document into the scanner, either on the document 
glass or in the document feeder, and adjust settings as 
needed on the Basic Features tab.

2. Click the Image Size tab.
3. Click the Preview button.
4. Select the Crop/Frame checkbox.
5. Click the Frame radio button.
6. In the Preview window, use the mouse to drag the bounding 

box until the hole punch marks are outside the bounding box.
7. Preview the document again to verify your adjustments.
8. When satisfied with the adjustments, click Scan.

NOTE: If you are scanning a stack of hole-punched documents 
from the feeder, preview just one to adjust the frame area. When 
the margins are set properly, place the page back in the stack and 
load the whole stack (up to 100 sheets) into the document feeder.
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Reduce/Enlarge

The Reduce/Enlarge tools scale the image to a smaller or larger 
size. The Reduce/Enlarge controls allow you to change the size 
of the image to fit specific dimensions or by a percentage. The 
amount by which you can reduce or enlarge the image depends 
on the scan resolution and the size of the original.
NOTE: Scanners enlarge images by scanning at a higher sample 
density (SPI) than requested. When the image is displayed at the 
requested DPI, it appears larger than the original because it 
contains more dots than it would have if scanned at the requested 
SPI. When you scan from the automatic document feeder at 600 
SPI and enlarge the document, the scanning speed will be 
reduced noticeably. There is nothing wrong with the scanner.

For a further understanding of dpi/spi and resolution refer to 
Chapter 9, “Understanding Resolution” on page 9-3.

Using the Scale To feature: The Scale To feature allows you to reduce or enlarge the original 
by a percentage amount. Simply select the radio button to 
activate the feature and enter a percentage value in the Width and 
Height fields.

Using the Fit In feature: The Fit In feature allows you to reduce or enlarge the original by a 
precise measurement. Simply select the radio button to activate 
the feature and enter the new dimensions for Width and Height.

Preventing the image from
becoming distorted:

The Proportional feature automatically preserves the aspect ratio 
(the ratio of the width to the height of the image). This feature 
prevents you from distorting the image, and is especially useful 
when used in conjunction with the Fit In feature.
NOTE: When using the [Proportional] feature with the [Fit In] 
feature, the image will not exceed the dimensions entered. For 
example, if you try to make an 8.5 x 11 inch document fit in an 8.5 
x 14 inch space, no enlargement will occur, because to do so 
would make the output image exceed the 8.5 inch width.
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Preview window

The Preview window is used to adjust margins for cropping and 
framing, and for previewing adjustments to image quality prior to 
scanning.

Preview
window
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Using the Preview Window

When you click the Preview button, a representation of the 
scanned image appears in the Preview window. Use the Preview 
window to set Crop/Frame margins, create and edit Image Quality 
Windows, and to adjust Image Quality settings.
To enable the Preview window, select View: Show Preview.
NOTE: By default, the Preview feature is set to perform a fast 
preview of your image at a reduced resolution, regardless of the 
chosen scan resolution. If you wish to preview at the actual 
resolution, select Options: Fast preview to disable fast preview; 
when disabled, there is no checkmark next to the feature name.

Changing the Zoom factor

To change the Zoom factor, use the following procedure:
1. Click either the Zoom In (+) or Zoom Out (-) tool 

buttons.

2. Click on the image in the Preview window. The Preview will 
resize accordingly, and the area clicked will center itself in the 
Preview window.

NOTE: There are several different ways to change the zoom 
factor. One way is the above procedure, or you can choose one 
of the following ways to change the zoom factor:

• Click the Zoom dropdown menu on the Preview window, then 
choose a Zoom factor from the list; or
Click View: Zoom and select a Zoom factor from the list; or

• Press CTRL + I to increase the Zoom and CTRL + O to 
decrease the Zoom.
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Previewing both sides of a 2-sided document

When you preview a bound document on the Document Glass or 
a 2-sided document from the Document Feeder, the A/B toggle 
will become enabled at the top of the Preview pane.
To Preview both sides of a 2-sided document, use the following 
procedure:

1. Click A to view the first side.

2. Click B to view the second side of the image.

NOTE: This feature is especially useful for previewing 
mirrored Crop/Frame margins. To enable mirrored margins, 
select the Mirror Side 2 checkbox on the Image Size tab.

Adjusting the Crop/Frame bounding box

The Preview window allows you to visually adjust the margins of 
the bounding box. Use the Zoom control to zoom in for more 
detailed adjustments or to zoom out for a full page view.
To adjust the Crop/Frame bounding box, use the following 
procedure:
1. Place the mouse cursor over one of the sizing handles. The 

arrow cursor will change to a double-pointed arrow. 

2. Click and drag the sizing handle to change the position of the 
bounding box.
NOTE 1:If you want to recreate a Crop/Frame bounding box, 
click once outside the current box, then click and drag to 
create the new box.

NOTE 2:For fine adjustments of the Crop/Frame bounding 
box, use the margin controls on the Image Size tab.
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Using interactive preview (Single Page Mode)

Single page mode allows you to scan a stack of documents, one 
at a time, from the document feeder. In this mode, the top page is 
fed, scanned and kept in the scanner's memory until you either 
accept the scan or skip to the next page. This mode is designed 
to help you adjust image quality, as you can continue to reprocess 
the image without reloading the page in the feeder as many times 
as necessary.
NOTE: The selection for Single Page Mode is not saved in any 
Scan Tickets. If you select a scan ticket and you wish to scan one 
page at a time you must manually select the Single Page Mode 
checkbox.

To use interactive preview (single page mode), use the following 
procedure
1. Setup your scan on the Basic tab.
2. Load pages in the document feeder.
3. Select the Single Page Mode check box.
4. Click Preview.
5. Click the Image Size tab and crop, frame or resize the image 

if desired. (You cannot preview the effects of Image Size 
adjustments, but you can use the preview window for 
positioning the bounding box.)

6. Click the Image Quality tab.
7. Adjust image quality controls one at a time as necessary, and 

click Reprocess after each adjustment to see its effect.
8. When you are satisfied, click Accept to keep your changes 

and pass the scanned image back to your scanning 
application.
NOTE: If you have selected Options: Single Page Mode: 
Automatically Preview Next Image then the green button 
will be labeled "Next," not "Accept." When you click Next, 
your changes are saved, the image is sent to your scanning 
application, and the scanner automatically previews the next 
document on the stack.
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9. If you do not want to scan the page, click Skip to delete the 
preview image and reject your changes.

10. Click Preview to feed the next page through the scanner 
(unless you have Automatic Preview enabled).

NOTE: Single page mode can be used with the Fine Adjustments 
controls and with the Image Quality Windows dialog. You should 
note that if you click Close to exit the Image Quality Windows 
dialog instead of clicking Next or Accept, your current preview will 
be flushed from the scanner memory. If you still wish to scan that 
page, you will have to reload it in the document feeder and 
preview it again.
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5. Job Ticket/Job Setup

This chapter defines what a job ticket/job setup is and discusses 
the various options available with the job ticket option.

What is a job ticket?

A job ticket is an electronic record that specifies printing and 
finishing options for a document. The job ticket options available 
for your document are listed in the Job Setup dialog box.

Also known as... The job ticket options, also known as Job Setup or printer settings 
options, provide many printing and finishing options that are 
supported by Xerox Production Printers. These options vary by 
printer model and configuration at the time of installation.

Overview of job ticket options

Depending on your digital press/printer, the available job ticket 
options will vary. The following options may or may not be 
available with your digital press/printer:
• Specify the job type, image position, and sides imaged of your 

output document
• Change the size or position of an image on the output pages
• Specify the collation, output, and finishing options for your 

output
• Specify the number of copies and the destination of your 

output 
• Add job notes to your output
• Specify paper stocks for the entire document and for selected 

pages
• Add covers or slip sheets to your output
• Specify pages of your output as chapter starts or add blank 

insert pages to your output
• Create special pages for your document
• Specify individual preferences for your specific print job 

including units of measure and dialog options
• Specify color quality features to apply to your output as it is 

printed
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Accessing the job ticket

You can access the job ticket options one of three ways:
• From the Scan and Print application or 
• From the Production Printer Settings application or 
• From the Quick Print application.
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

From Scan and Print: Select the More Options... button.
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The Job Setup dialog displays.

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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...Or you can access it from
Production Printer

Settings:

Select the Create Job Ticket button.

The Job Setup dialog displays.

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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...Or you can access it from
Quick Print:

Select the Job Setup button.

The Job Setup dialog displays.

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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Job Setup tabs

The Job Setup/Job Ticket dialog box contains the following tabs:
• Imaging/Job Setup
•  Job Notes
• Paper Stocks
• Color/Image Quality
• Preferences
Each of these tabs and their options are discussed on the 
following pages.
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.

Imaging/Job Setup tab

Copies: Select the number of desired output copies either by typing in a 
number in the Copies field or by using the up/down arrows to the 
right of the field.

Specify which pages to
print:

If you are printing more than one page, check the All pages check 
box to print all pages of your document, or clear the All pages 
check box and enter the range of pages to print. Type the starting 
page in the From text box and the last page in the To text box.
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Job Type: Select the specific job type from the drop-down list. There are 
three primary job types, some with subtypes:
• Standard: Prints the document pages in sequential order, 

using single sheets of paper stock. A standard job can be
1-sided (simplex), 2-sided (duplex) or Head-To-Toe (duplex).

• Signature: Prints the document pages non-sequentially, to 
produce folded output. Signature jobs are always duplex. 
Some finishing options may be disabled when printing 
signatures. You can use the Autofit option to scale images in a 
Signature job in the job ticket.

– Book signatures: Document width is greater than 

the height, and pages are duplex.

– Calendar signatures: Document height is greater 
than the width, and pages are head-to-toe.

– Pamphlet signatures: Document height is 

greater than the width, and pages are duplex.
• N Up: Prints the same page an N amount of times on the 

output paper. The options available for each N Up option differ 
for each N Up option.

– 2-Up: Prints the same page twice, side by side, 

on one side of a page. You can change the paper size, if 
necessary. Image Shift is not available.

– 2-Up flip left: Prints the same page twice, side 

by side, on one side of a page, with the left-side image 
rotated 180 degrees. You can change the paper size, if 
necessary. The Orientation depends on the N-Up type you 
choose. Image Shift is not available for 2-Up flip left. This 
option is often selected when using offline cutting and 
binding.
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– 2-Up flip right: Prints the same page twice, side 

by side, on one side of a page, with the right-side image 
rotated 180 degrees. You can change the paper size, if 
necessary. The Orientation depends on the N-Up type you 
choose. Image Shift is not available for 2-Up flip left. This 
option is often selected when using offline cutting and 
binding.
NOTE: If you change the paper size to a stock with the 
length greater than the width, the orientation of the job is 
set to landscape.

– 3-Up: Prints the same page three times, side by 

side, on one side of a page. You can change the paper 
size, if necessary. Image Shift is not available.

– 3-Up flip left: Prints the same page three times, 

side by side, on one side of a page, with the left-side image 
rotated 180 degrees. You can change the paper size, if 
necessary. The Orientation depends on the N-Up type you 
choose. Image Shift is not available for 3-Up flip left. This 
option is often selected when using offline cutting and 
binding.

– 3-Up flip right: Prints the same page three 

times, side by side, on one side of a page, with the right-
side image rotated 180 degrees. You can change the 
paper size, if necessary. The Orientation depends on the 
N-Up type you choose. Image Shift is not available for 3-
Up flip left. This option is often selected when using offline 
cutting and binding.

– 4-Up: Prints the same page four times on one side 

of a page. You can change the paper size, if 
necessary. The Orientation depends on the N-Up type you 
choose. Image Shift is not available for N-Up.
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– 8-Up: Prints the same page eight times on one 

side of a page. You can change the paper size, if 
necessary. The Orientation depends on the N-Up type you 
choose. Image Shift is not available for N-Up.

– 16-Up: Prints the same page sixteen times on 

one side of a page. You can change the paper size, if 
necessary. The Orientation depends on the N-Up type you 
choose. Image Shift is not available for N-Up. 

NOTE: To use Signature or N-Up Flip, create the document 
so that the page is half the size of the paper stock selected at 
print time.

– Custom: Specify a custom N-up job type. You must 
select from 1-16. Specify the number of Rows and 
Columns by typing in the field or by using the up/down 
arrows to the right of the field.

NOTE: The Job Type options may vary depending your color 
server and finishing devices attached to your digital press.
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Image descriptions: Select the Orientation and Sides Imaged from their respective 
drop-down lists:
• Select Portrait if the short sides are the top and bottom edges 

and the long sides are the right and left edges.
• Select Landscape if the long sides are the top and bottom 

edges and the short sides are the right and left edges.
• Select 1-Sided to print images on only 1 side of your output 

paper.
• Select 2-Sided to print images on both sides of your output 

paper.
• Select Head to Toe to print images on both sides of your 

output paper in head-to-toe format.

Image operations: In the Image operations area, select the Image shifts options and 
the Scale option (if applicable).
• Image shifts alter the page shift for the front page or the front 

and back page depending the Sides Imaged selection.
– X: This is the distance to shift the page(s) in a horizontal 

direction from the left edge of the paper. A positive 
number (+) shifts the page to the right; a negative number 
shifts the page to the left. X distance is applied to all 
specified pages unless X2 is enabled. If X2 is enabled, X 
is for ordinal odd pages.

– Y: This is the distance to shift the pages in a vertical 
direction from the top edge of the paper. A positive 
number (+) shifts the page up; a negative number shifts the 
page down. Y distance is applied to all specified pages 
unless Y2 is enabled. If Y2 is enabled, Y is for ordinal odd 
pages. 

• Scale: Enter a Scaling value in the Scale to text box. You can 
scale an image down to 1% of the original size or enlarge the 
image up to 1000% of the original size.
Check the Auto-Fit button to automatically scale the image 
from the original size to fit on the output paper stock size.
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Job setup: From the Job setup area, make your desired selection for 
Collation, Output, and Finishing:
• Collation: From the drop-down list box, select either:

– Collated - to print multiple copies of a document in 
sequential order.

– Uncollated - to print multiple copies of a document 

by page number.
• Output: From the drop-down list, select your desired output 

option.

NOTE: The output devices shown here may or may not be 
available for your system.

For more information about Output, refer to the online Help 
(Job Setup/Help button/Specifying output finishing options).

• Finishing: From the drop-down list, select your desired 
finishing option.

For more information about Finishing and Output, refer to the 
online Help (Job Setup/Help button/Specifying output finishing 
options).
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Job Notes

NOTE: The available Job Notes fields depends on your digital 
press.

You can create job notes for a specific job by typing in the Special 
Instructions area. If you save this job ticket, these special 
instructions are saved with it.

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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Paper Stocks

NOTE: The available paper stocks depend on your digital press.

Select the desired Size and Stock type from their respective 
drop-down lists.

Check the Printer Default check box to print to the default paper 
stock weight. Clear the Printer Default check box to enter a 
different paper weight in the Weight text box, to select a weight 
from the Weight drop-down menu, or to print to a paper stock 
weight other than the printer default.
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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Color/Image Quality

The Color/Image Quality tab settings control how images and text 
are printed by the target production printer. These settings will 
vary depending on the selected production printer.

When a color printer is selected, users can adjust image 
brightness, color mode (grayscale or color), image and text 
sharpening, and black detection. Additional color rendering 
options are available if the users selects the Expert color (custom) 
color mode.
For additional information on this tab, refer to the online Help (Job 
Setup/Help button/Image Quality settings).

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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Preferences

NOTE: The available Preferences options depend on your digital 
press.

From this tab you can:
• Check the Default job ticket checkbox if you want to use the 

default job ticket settings
• Uncheck the job ticket checkbox if you want to Browse to and 

use an existing job ticket for your job
• Select your unit of measurement for custom paper sizes
• Select your unit of measurement for image shifts (if applicable)
• Select the More Options buttons to display additional options
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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More Options

Clicking the More Options button opens the Display Options dialog 
box.

Clear the checkboxes next to the options you wish to hide in the 
associated tab dialog. For example, if you wish to hide the 
stapling options, clear the stapling checkboxes and select 
Save. The next time you open Job Setup, these stapling options 
will not be displayed in the Finishing drop-down list on the 
Imaging/Job Setup tab.
KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
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Job Setup buttons

On the bottom of the Job Setup dialog box are three buttons:

Use these buttons for:

• Resetting the job ticket defaults: Click this button to 
restore the job ticket to its default options.

• Saving the job ticket: Click this button to save your job 
ticket settings.

• Opening an existing job ticket: Click this button to 
access and open an existing job ticket.
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6. Quick Print

Quick Print allows you to quickly access, create a job ticket, and 
print a job that was previously scanned and saved.

Printing a single file

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
Use the following procedure to print a single file.
1. Select Start: Programs: Xerox FreeFlow Software: Quick 

Print.
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KEY POINT:This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press 
and color server for your work environment.
The Quick Print dialog box opens:

2. Select the file type you wish to print in the Show file type 
pull-down menu.

3. Browse to the directory where the document is stored and 
select the file name of the document from the directory tree 
list. The selected filename will appear in the file selected 
field.

4. Select a printer from the Printers pull-down menu.
5. Click the Printer Settings button to modify the printer 

settings as necessary. 
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6. Specify the number of copies to be printed. 

If you do not want to print the entire document, deselect the 
All checkbox and select the sequence of pages to print:
a. Specify the starting page in the From list box. 
b. Specify the last page to print in the To list box. 
c. Click the Job Setup button to modify the job ticket 

settings as necessary. 
NOTE: The Job Setup button is disabled if an Adobe PDF file 
or an RDO with PDF pages that has been secured against 
printing. An error message is displayed and notifies the user 
that the PDF has been secured. The button is also disabled 
if the Print as separate jobs option is selected.

The Print as file type pull-down menu allows the user to 
select the appropriate output format for files that do not have 
the necessary file extension. Selecting an option other than 
Printer default will NOT cause the file to be converted to the 
selected file type.

7. Select the appropriate radio button:

• Print as one job: Jobs are printed as one job. The 
default job ticket is applied, but can be modified by 
clicking the Job Setup button.

• Print as separate jobs: Jobs are printed separately with 
the default job ticket applied to each file. Job Setup and 
Page Range options are disabled. 

8. Click Print to submit the job to the printer. 

NOTE 1: A dialog appears if the file contains PDF pages 
secured against printing. Follow the instructions in the dialog 
to print the file.

NOTE 2: If Image Optimization for the selected printer has 
been enabled, print speed will be effected. Click the Cancel 
button and disable the optimization option if print speed is 
more important than image quality.
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Printing a job with multiple files

1. Select the file type you wish to print in the Show file type 
pull-down menu.

2. Select the List multiple files to print checkbox.

The Quick Print window expands to reveal the job list at the 
bottom of the screen.

3. Browse to the location of the document from the directory 
tree box.

4. Highlight the file name of the first document to print. 
5. Click Add button. The file name appears in the job list.
6. Repeat this process until you have added all of the desired 

jobs.
7. Use the Move up and Move down buttons to arrange files in 

the appropriate print order from top to bottom.
8. Click the Remove button to remove a selected file from the 

print list, or the Remove All button to clear the list.
9. Select a printer from the Printers pull-down menu.
10. Click the Printer Settings button to modify the printer 

settings as necessary.
11. Specify the number of copies to be printed. 
12. If you do not want to print the entire document, deselect the 

All checkbox and select the sequence of pages to print:
a. Specify the starting page in the From list box.
b. Specify the last page to print in the To list box.

13. Click the Job Setup button to modify the job ticket settings 
as necessary.
NOTE: The Job Setup button is disabled if an Adobe PDF file 
or an RDO with PDF pages that has been secured against 
printing. An error message notifying the user that the PDF 
has been secured will be displayed. The button will also be 
disabled if the Print as separate jobs option has been 
selected.

14. The Print as file type pull-down menu allows the user to 
select the appropriate output format for files that do not have 
the necessary file extension.
Selecting an option other than Printer default will NOT cause 
the file to be converted to the selected file type.
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15. Select the appropriate radio button:

• Print as one job: Jobs are printed as one job. The 
default job ticket is applied, but can be modified by 
clicking the Job Setup button.

• Print as separate jobs: Jobs are printed separately with 
the default job ticket applied to each file. Job Setup and 
Page Range options are disabled.

16. Click Print to submit the jobs to the printer in the order they 
are listed.
NOTE 1: A dialog appears if the file contains PDF pages 
secured against printing. Follow the instructions in the dialog 
to print the file.

NOTE 2: If Image Optimization for the selected printer is 
enabled, print speed are effected. Click the Cancel button 
and disable the optimization option if print speed is more 
important than image quality.
FreeFlow Scanner 665E Operator Manual 6-5



6.  Quick Pr int
Printing all the files in a selected directory

To print all the files in a selected directory:
1. Select the file type you wish to print in the Show file type pull-

down menu.
NOTE: By selecting a file type, only files of that type found in 
the directory will be printed. For example, if TIFF is the 
selected file type, all the TIFF files in the directory will be 
printed.

2. Browse to the directory location and select the directory in 
the tree list. The directory path along with all the file 
extensions for the selected file type will appear in the File 
selected field.

3. To print additional files or directory contents, perform the 
following:
a. Select the List multiple files to print checkbox. The 

Quick Print window expands to reveal the job list at the 
bottom of the screen.

b. Click the Add button to add the contents of the directory 
selected above. Files matching the selected file type will 
appear in the job list.
NOTE: If you have selected Adobe PDF or RDO files 
containing PDF files that are password protected, you 
will be prompted to change the security settings for those 
files in Adobe Acrobat, and then re-add them.

4. Browse to the location of the next document or directory 
using the directory tree box, or select a different file type from 
the Show file type pull-down to add files of that type from the 
same directory.

5. Highlight a file name or directory name in the Directory tree.
6. Click the Add button to add the file name or directory 

contents to the job list.
7. Repeat this process until you have added all of the desired 

jobs.
8. Use the Move up and Move down buttons to arrange jobs in 

the appropriate print order from top to bottom.
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9. Click the Remove button to remove a selected job from the 
print list, or the Remove All button to clear the list.

10. Select a printer from the Printers pull-down menu.
11. Click the Printer Settings button to modify the printer 

settings as necessary.
12. Specify the number of copies to be printed.
13. Click the Job Setup button to modify the job ticket settings 

as necessary.
NOTE: The Job Setup button will be disabled if an Adobe 
PDF file or an RDO with PDF pages has been selected that 
has been secured against printing. An error message 
notifying the user that the PDF has been secured will be 
displayed. The button will also be disabled if the Print as 
separate jobs option has been selected.

14. The Print as file type pull-down menu allows the user to 
select the appropriate output format for files that do not have 
the necessary file extension. Selecting an option other than 
Printer default will NOT cause the file to be converted to the 
selected file type.
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15. Select the appropriate radio button:

a. Print as one job: Jobs are printed as one job. The 
default job ticket is applied, but can be modified by 
clicking the Job Setup button. 

b. Print as separate jobs: Jobs are printed separately 
with the default job ticket applied to each file. Job Setup 
and Page Range options are disabled.

c. Click Print to submit jobs to the printer. If multiple jobs 
are being printed, they will be submitted in the order they 
are listed.
NOTE 1: A dialog will appear if the file contains PDF 
pages secured against printing. Follow the instructions in 
the dialog to print the file.

NOTE 2: If Image Optimization for the selected printer 
has been enabled, print speed will be effected. Click the 
<Cancel> button and disable the optimization option if 
print speed is more important than image quality.
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7. File Manager

This chapter discusses the File Manager application and provides 
instructions on how to copy, move, and delete objects or files.

What is File Manager? 

File Manager is a substitute for the Windows Explorer, enabling 
you to manage large numbers of documents stored on the 
Windows file system. Use File Manager for moving and copying 
RDO objects.
KEY POINT: DO NOT try to copy or move RDO documents using 
Windows Explorer; it is unfamiliar with RDO files and cannot 
manage them.
File Manager also enables you to copy, delete, and move objects, 
print files, connect to network drives, run applications, and 
maintain disks.

File Manager capabilities

File Manager provides the following capabilities:
• Creating and managing directories 
• Searching to find files 
• Managing files 
• Labeling and formatting disks
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What is displayed in the File Manager window?

KEY POINT: This book uses illustrations showing a DocuColor 
8000 Digital Press connected to a Fiery EXP8000 color 
server. Your system may vary depending on the digital press and 
color server for your work environment.
The File Manager window displays a directory tree and a directory 
contents list; a directory tree only; or a directory contents list only. 

• The directory tree displays the structure of the desktop as a 
set of levels. The highest level is the desktop which contains 
all other levels. Drives and storage devices, both local and 
remote, generally comprise the next level. The remaining 
levels are comprised of directories, subdirectories, and files.

• The directory contents list displays the subdirectories and files 
for a specified directory. The contents can be displayed as 
icons or a list of names. When contents are listed, their 
attributes are also displayed.

If both the directory tree and directory contents list are displayed, 
they are separated by a split bar.
Both a Status Bar and Toolbar can be displayed. The Toolbar can 
be customized.
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Icons

File Manager uses the following icons to represent drives, 
directories, and file types.

•  Non-specific file

•  Associated file

•  .RDO document

•  PostScript file

•  Directory

File Manager menus 

File Manager has the following menus:
• File menu
• Network menu
• Volume menu
• Tree menu
• View menu
• Options menu
• Window menu
• Help menu
Each menu is briefly discussed starting on the next page.
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File menu

This menu contains of the following:
• Move: Allows you to move a file or directory.
• Copy: Allows you to copy a file or directory.
• Delete: Allows you to delete a file or directory.
• Rename: Allows you to rename a file or directory.
• Properties: Provides a dialog for choosing the file Attributes, 

such as Read Only, Archive, Hidden, or System.
• Run: Displays the Run dialog box, which allows you to start 

an application from the directory contents list.
• Print: Allows you to print the selected file from the contents 

list.
• Associate: Opens the Associate dialog box, which allows you 

to:
– Select a file with an extension that you want to associate 

with an application,
– Select a file that has an extension for which you want to 

change the association, or
– Remove the association between a file and an application.

• Create Directory: Opens the Create Directory dialog box, 
which allows you to create a new directory at the level 
(location) you specify.

• Search: Opens the Search dialog box, which allows you to 
enable File Manager to search for specific files or folders. 

• Select Objects: Opens the Select Objects dialog box, which 
allows you to select non-contiguous files from the contents 
list. Once selected, you can perform an operation such as 
move or delete on the selected files. 

• Exit: Closes the File Manager.
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Network menu

This menu contains the following:
• Map Network Drive: Opens the Map Network Drive dialog 

box, which allows you to connect to shared directories on the 
network. This is a standard Windows Map Network Drive 
dialog box.

• Disconnect Network Drive: Opens the Disconnect Network 
Drive dialog box, which allows you to disconnect your 
computer from a network drive.

• Share As: Opens the New Share dialog box, which allows 
you to share a directory.

• Stop Sharing: Opens the Stop Sharing Directory dialog box, 
which allows you to stop sharing directories. 

Volume menu 

This menu contains the following:
• Label Volume: Opens the Label Volume dialog box, which 

allows you to assign a label to a volume.
A Volume Label is an attribute that names the volume in which 
the object is contained. It uses a string format and is case 
sensitive. 
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Tree menu 

This menu contains the following:
• Expand One Level: Displays one level of subdirectories for 

the selected drive or directory in the directory tree window.
You can use the + shortcut key to perform this operation on the 
selected drive or directory.

• Expand Branch: Displays all subdirectories for the selected 
directory in the directory tree window.

You can use the * shortcut key to perform this operation on the 
selected directory.

• Expand All: Displays all subdirectories for an entire drive.

You can use the CTRL + * shortcut keys to perform this 
operation on the selected drive.

• Collapse Branch: Hides all subdirectories for the selected 
directory in the directory tree window.

You can use the - shortcut key to perform this operation on the 
selected drive or directory. 

View menu 

This menu contains the following:
• Tree and Directory: Displays both the directory and the 

directory contents list in the directory tree window. 
• Tree Only: Displays a directory tree only in the directory tree 

window. 
• Directory Only: Displays the directory contents only in the 

directory tree window.
• Split: Allows you to move the split bar in the directory tree 

window. Use this command to change the display area 
allocated to either the directory or directory contents list.

• Large Icons: Displays the directory contents as large icons.
• Small Icons: Displays the directory contents as small icons.
• List: Displays the directory contents as a list.
• All Details: Displays the directory contents list with complete 

object information. The directory contents list displays the files 
and subdirectories for the selected directory.

• Partial Details: Opens the Partial Details dialog box, which 
allows you to customize the directory contents list to display 
specific object details. 
FreeFlow Scanner 665E Operator Manual7-6



7. Fi le Manager
• Arrange object icons: Allows you to sort objects in the active 
directory by name, by type, by size, by date, or by specified 
attribute. Also allows you to arrange items so they do not 
overlap one another and so that all text is clearly visible.

• Line Up Icons: Arranges icons in the directory contents list 
into columns.

• By Object Type: Opens the Object Type dialog box, which 
allows you to specify the type of objects displayed in the 
directory window.

Options menu 

This menu contains the following:
• Confirmation: Opens the Confirmation dialog box, which 

allows you enable or disable confirmation messages when you 
delete, copy, or move objects and directories.

• Font: Opens the Font dialog box, which allows you to change 
the display font File Manager used for the directory windows. 
The font change applies to all directory windows.

• Customize Toolbar: Opens the Customize Toolbar dialog 
box, which allows you to add, remove, or arrange the buttons 
in the Toolbar.

• Toolbar: Allows you to display or hide the Toolbar.
• Status Bar: Allows you to display or hide the Status Bar.
• Minimize On Use: Allows you to reduce File Manager to an 

icon when the application is running.
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Window menu 

This menu contains the following:
• New Window: Opens an additional window in File Manager.
• Cascade: Displays the window(s) in a cascade pattern.
• Tile Horizontally: Displays the window(s) horizontally.
• Tile Vertically: Displays the window(s) vertically.
• Arrange icons: Arranges the icons in your window(s).
• Refresh: Refreshes the window(s) to reflect changes you 

have made.
• Directory list: Lists the directory(s) currently open in File 

Manager.

Help menu 

This menu contains the following:
• Help Topics: Opens the File Manager Help application.
• About File Manager: Opens the File Manager Information 

dialog box, which contains copyright information for the File 
Manager application. 
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Using File Manager Help

The online Help provides in depth, step-by-step instructions for 
using the various FIle Manager features and functions, including:
• Navigating the directory window: This includes information 

and instructions for:
– Connecting a network drive
– Disconnecting a network drive
– Selecting a drive
– Selecting a directory and 
– Expanding or collapsing a directory tree

• Working with directories: This online Help information 
includes step-by-step instructions for:
– Creating a directory
– Searching for a directory
– Moving a directory
– Copying a directory
– Deleting a directory
– Renaming a directory
– Sharing directories in File Manager
Also included here are details about sharing information 
across host workstations.
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• Working with files: This includes information and instructions 
for:
– Selecting a file or group of files
– Canceling selected files
– Copying a file
– Moving a file
– Renaming a file
– Deleting a file
– Printing a file
– Searching for a file
– Opening a file
– Associating a file with an application
– Starting an application

• Working with disks: This includes information about:
– Labeling a volume on a floppy disk
– Labeling a volume on a hard disk
– Labeling a volume on an optical disk
– Formatting a disk

• Customizing File Manager: This includes information and 
instructions for:
– Customizing the File Manager window
– Moving the split bar"
– Minimizing File Manager window
– Changing the File Manager window font
– Opening a new directory window
– Arranging multiple directory windows
– Arranging object icons
– Refreshing directory windows
– Closing a directory window
– Changing information displayed in the contents list
– Displaying specific object details
– Choosing the type of objects to display
– Sorting objects
– Customizing the Toolbar
– Displaying or Hiding the Status Bar
– Displaying or hiding confirmation messages
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To access and use the online Help for File Manager, perform the 
following steps:
1. From Windows Start: Programs, select Xerox FreeFlow 

Software: File Manager. The File Manage application 
opens:

2. From the Help drop-down list, select Help Topics.
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The Help dialog is displayed.

3. Select the desired Help topic.

4. When finished, close the Help dialog box by selecting  
(Close) in the title bar.
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8. Security Certification

If your site requires a high security communication and you are 
connected to a DocuSP color server, you will need to implement 
the client-side secured FTP and/or Secure IPP security certificate 
in order to communicate with the DocuSP 4.x/5.x color server.  
This is discussed in detail in the System Adminstration Guide, 
Chapter 6, “Installing a security certificate” on page 6-11.
The Security Certification application is used for installing the 
certificate and checking the status of an existing certificate on the 
DocuSP 4.x/5.x color server.

NOTE 1: The security certificate must be enabled on the DocuSP 
color server. Refer to your DocuSP documentation for more 
information.
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9. Hints and tips

This chapter provides hints and tips to help you work more 
efficiently with the FreeFlow Scanner software.
NOTE: Hints and Tips may also be accessed from the online Help.

Page feed direction and image orientation

Page feed controls have no relationship to output image 
orientation. Page feed direction and image orientation are 
mutually exclusive.

Definition of portrait and landscape

Portrait orientation is where the image is upright on a paper 
aligned vertically. Landscape orientation is where the image is 
upright on a paper aligned horizontally.

Portrait
Landscape
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9.  Hints and t ips
Definition of SEF and LEF

SEF (short edge feed) refers to the shorter edge of a document as 
the first edge to contact the Document Feeder rolls; for example, 
the 8.5 inch side of an 8.5 x 11 inch document.
LEF (long edge feed) refers to the longer edge of a document as 
the first edge to contact the Document Feeder rolls; for example, 
the 11 inch side of an 8.5 x 11 inch document.
The page feed and orientation controls are only used to describe 
to the scanner how the original image has been loaded into the 
document feeder. They have no bearing on how your image is 
oriented (landscape or portrait) when printed.
The SEF/LEF toggle buttons and the Rotate A button (Advanced 
Scanning) have no relationship to final image orientation. When 
properly set, they simply ensure that when previewing, your image 
appears upright in the Preview window.
NOTE: When scanning large numbers of documents from the 
Document Feeder, arrange them LEF to achieve faster throughput 
speed.

Guide to choosing an Original Type for your scan

Use the following table to help you choose which Original Type 
(Advanced Scanning) to choose for your original documents:

LEF SEF

If your original is: Choose

A mixed batch of originals, of different 
type or of multiple types per page, such 
as halftones with text

Automatic

A photograph or continuous tone image, 
or a very high frequency halftone with a 
screen frequency higher than 200 lpi, or a 
mix of several types of images

Photograph

A halftone with a screen frequency 
between 112 and 200 lpi

Fine Halftone

A halftone less than 112 lpi Coarse Halftone

Text or line art Text

A mix of coarse halftones and text, such 
as found in a newspaper

Coarse Halftone & Text
(Laser Print)

A mix of fine halftones and text, such as 
found in magazines

Fine Halftone & Text
(Magazine)

A mix of photographs and text. (For this 
purpose, treat halftones with a screen 
frequency higher than 200 lpi as 
photographs.)

Photograph & Text
(Paste-up)
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9.  Hints and t ips
Guide to choosing a Media Type

Use the following table to help you choose the best Media Type 
(Advanced Scanning) for your original documents:

Understanding Resolution

Choosing a Resolution option for your output image can be a 
difficult thing. You may ask, “What is the best resolution to 
choose?” In order to answer that question, you need to have an 
understanding of resolution. Before you choose a resolution from 
the drop-down list, read the following definition of “resolution” and 
how you can choose the best option for your scan job.
When you work with bitmap or digital images like digital 
photographs, you work with pixels. Pixel stands for picture 
element. A pixel is the smallest unit in a computer image or 
display. Every image on your computer is made up of a colored 
grid of pixels.
For example, your digital camera records pixels, your scanner 
converts physical images into pixels, your photo editing software 
manipulates pixels, your computer monitor displays pixels, and 
your printer paints pixels onto paper. In the digital world, "inches" 
do not exist, only pixels do.

If your original is: Choose

A continuous tone image developed on 
light-sensitive paper using a chemical 
emulsion

Photograph

An original that was printed with oil-based 
inks on an ink jet printer

Inkjet

An original that was printed with oil-based 
inks on a web or sheet fed offset press. 
Common examples include newspapers, 
posters, books, magazines

Fine Lithographic

An original that was printed by fusing 
electrostatic toner to paper

Laser/Xerographic

Any original that does not fall into the 
above categories

Unknown/Other
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9.  Hints and t ips
The key to successfully editing, scanning, and printing images lies 
in understanding how pixels transform into inches and vice versa. 
Resolution is the interpreter between the physical world of inches 
and the digital world of pixels. When you scan an image, the 
scanner translates inches into pixels using resolution. When you 
print an image, the printer translates pixels into inches using 
resolution. So what's resolution? Unfortunately, the word is used 
in different ways in different contexts. "Camera resolution" usually 
means something slightly different from "image resolution,” and 
"printer resolution" is something else yet again.

The two faces of resolution

“Resolution” is used in two basic ways. In some contexts, 
resolution refers to the pixel count of an image. An image with lots 
of pixels is often called a "high resolution" image. However, in 
other contexts, resolution refers to the density of pixels in a given 
linear area such as an inch. This "density" is expressed as ppi 
(pixels per inch) or dpi (dots per inch), and this density number is 
embedded invisibly in a bitmap image, as an instruction to output 
devices, such as a printers. For clarity, we will refer to the first 
type of resolution as pixel count resolution and the second as 
embedded resolution.

The difference between pixel count resolution & embedded resolution

Embedded resolution tells your printer how far apart to spread the 
pixels in a printed image. It determines how "fine grained" the 
printed image will look. It is completely independent of the pixel 
count of the image. A high-pixel-count image can have a low 
embedded resolution or vice versa. Embedded resolution is 
inversely proportional to the size of the printed image. Given the 
same pixel count, a high embedded resolution will result in a 
smaller printed image (the pixels are packed together more 
tightly), and a low embedded resolution will result in a larger 
image (the pixels are more spread out).
Embedded resolution, however, does not affect the size (in bytes) 
of your image or its appearance on a computer screen; those 
properties are determined solely by the pixel count. The byte-size 
of the image file is directly proportional to the pixel count, as is its 
size on your computer screen, which simply displays all the pixels 
in the image in a fixed one-to-one grid.
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9.  Hints and t ips
What is the difference between ppi and dpi?

The term ppi (pixels per inch) originated in the world of computers, 
and dpi (dots per inch) in the world or printing, but today they are 
often used interchangeably.

What resolution should I use to scan an image?

As with taking a digital photo, your intended use for the image 
determines your best scanning resolution. For example, a 4x6 
inch photograph scanned at 300 ppi will have large pixel 
dimensions and will appear large on a computer screen, while the 
same photograph scanned at 72 ppi will have fewer pixels and will 
appear much smaller on a screen.
Scanning resolution is expressed in terms of dpi or ppi. The 
scanning resolution not only determines how many pixels will be 
captured, it also gets embedded into the image as an invisible 
piece of information for future output devices. To calculate the 
pixel dimensions of a scanned photograph, multiply the scanning 
resolution by the dimension in inches: Resolution x Inches = 
Pixels. Using this formula you can calculate the pixel dimensions, 
for example, of a 4x6 inch photograph scanned in using 300 ppi:
• 300 pixels/inch x 4 inches = 1200 pixels
• 300 pixels/inch x 6 inches = 1800 pixels
This means that your 4" x 6" photograph will be displayed as 1200 
x 1800 pixels on your monitor, making it look very large on your 
monitor and causing the image to spill over the edges.
You could resize the scanned photograph in your main imaging 
application (such as Adobe Photoshop or Paint Shop Pro), or you 
could rescan it using a lower resolution (ppi) setting. To calculate 
the resolution that you should use to scan a photo/image, first 
decide how big you want your image to appear on your monitor 
(Pixels/Inches = Resolution).
For example, if you want your 4" by 6" photograph to appear as 
400 x 600 pixels on the monitor, then you would scan it in at 100 
ppi. If you want to create a 100 x 150 pixel thumbnail, you would 
scan in your 4 inch x 6 inch photograph at 25 ppi. 
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NOTE: Keep in mind that as you increase your scanning 
resolution you create larger files that might be inordinately large 
for e-mailing or web publishing. Below are a list of some possible 
resolution and image size combinations:

What embedded resolution should I use to print an image?

The chart below illustrates how embedded resolution affects the 
printed dimensions of an image:

Given the same number of pixels, a higher embedded resolution 
shrinks the final printed output.

Original image Scan resolution Pixel count .BMP file size

4x6 inches 72 ppi/dpi 288x432 364 kb

4x6 inches 100 ppi/dpi 400x600 703 kb

4x6 inches 150 ppi/dpi 600x900 1.54 mb

4x6 inches 200 ppi/dpi 800x1200 2.74mb

4x6 inches 300 ppi/dpi 1200x1800 6.17 mb

Pixel dimensions Image resolution Printed size

640 x 480 72 ppi
300 ppi

8.89" x 6.67"
2.13" x 1.60"

800 x 600 72 ppi
300 ppi

11.11" x 8.33"
2.67" x 2.00"

1024 x 768 72 ppi
300 ppi

14.22" x 10.67"
3.41" x 2.56"

1280 x 960 72 ppi
300 ppi

17.78" x 13.33"
4.27" x 3.20"

1600 x 1200 72 ppi
300 ppi

22.22" x 16.67"
5.33" x 4.00"

2400 x 1600 72 ppi
300 ppi

33.33" x 22.22"
8.00" x 5.33"
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How do I calculate what resolution I need to print a 4"x6" image? 

You can use the simple resolution formula to calculate the 
embedded resolution you need for any given output. For 
example, imagine a two megapixel camera that creates a 1600 by 
1200 pixel image. You can print this image at any number of 
different sizes by specifying different embedded resolutions. Take 
the length of the image in pixels and divide it by your target length 
in inches. The resulting number is the embedded resolution in ppi 
(or dpi):
• 1600 pixels/11 inches = 145 ppi
• 1600 pixels/10 inches = 160 ppi
• 1600 pixels/9 inches = 177 ppi
• 1600 pixels/8 inches = 200 ppi
• 1600 pixels/6 inches = 266 ppi
• 1600 pixels/4 inches = 400 ppi
• 1600 pixels/2 inches = 800 ppi
As your desired printing area decreases, your resolution 
increases. As a general rule, you can get a good, photo-quality 
print at 200 ppi or above. However, photo quality is in the eye of 
the beholder. You will probably need to experiment to find the 
resolution that looks acceptable on your printer.

What is printer resolution and do I need to worry about it? 

Printer resolution is the number of ink dots printed on an inch of 
paper measured in dpi (dots per inch). Most of today's printers 
have a resolution of 300 or 600 dpi. In most cases, the printer's 
resolution will not affect how you size and scale images. If you 
print your image at its actual size in inches, printer resolution will 
never effect the size of your printed image. 
If you want to control the quality of your printed image for a 
professional result such as an image destined for publication in a 
newspaper or magazine, you can calculate the optimal resolution 
for your image based on a printer's LPI (lines per inch).
For most printers there is an optimum image resolution, beyond 
which increasing the embedded resolution of the image (ppi) 
makes no discernible effect on the output quality. Each printer can 
only print so many lines per inch (LPI). LPI measures the number 
of halftone dots a printer can create in an inch of paper. Halftone 
dots are how a printer simulates continuous shades of colors while 
only using four colors: cyan, magenta, yellow, and black (some 
photo-quality printers also add light cyan and light magenta). 
Every individual pixel in your image will be represented by a 
random pattern of these smaller, various-sized printer dots. This 
process is also called screening or halftoning. 
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To obtain a quality print, your image resolution should be slightly 
higher than the printer's given LPI. To calculate this ideal 
resolution, multiply the LPI by about 1.5 to obtain the ideal pixel 
per inch (ppi) figure for your image. For example, given a 360 dpi 
photo-quality printer with a 150 lpi, you can get a photo-quality 
print if your image has 150 x 1.5 or 225 ppi. If you do not know 
your printer's lpi, the best way to find your optimal print resolution 
is to experiment. Print a test image at various resolutions to find 
out what your minimum ppi is for a photo-quality print. A good test 
image is a close up picture of a newspaper or a photo that has 
some angled straight edges in it.

Black and white scanning mode

In Black and White mode, scan Long Edge Feed (LEF) whenever 
possible. Scanning LEF allows the scanner image module to 
travel quickly across the document, allowing it to finish a scan 
quicker, and if scanning from the Document Feeder, to begin 
scanning the next document sooner. To scan a large stack of 
documents quickly using the Document Feeder, feed the stack 
LEF.
NOTE: When scanning in Grayscale or Color modes, feed your 
originals Short Edge Feed (SEF). This is significantly faster than 
Long Edge Feed for these modes.
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Using scan tickets

Scan tickets are a powerful feature of the scanner software. They 
allow you to store all the settings for common or complex scan 
jobs (including Image Quality Windows and Custom Page Sizes) 
so that you can quickly reload the settings instead of manually 
reprogramming the scan job.
Save common settings as Scan Tickets. This allows you to retain 
and reuse the scan settings from the Basic Features, Image 
Quality, and Image Size tabs, instead of manually entering them 
one at a time.
For more information on scan tickets and step-by-step instructions 
for creating, using, backing up, and deleting scan tickets, refer to 
the online Help (Advanced Scanning).

Using custom page sizes

The scanner supports many standard paper sizes, as well as 
allows the user to set custom page sizes. If you frequently scan 
odd-sized pages, save those sizes as custom page sizes to save 
yourself time.
For more information on custom page sizes and step-by-step 
instructions for creating and custom page sizes, refer to the online 
Help (Advanced Scanning).
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Using custom defaults

When the scanner software (Advanced Scanning) is launched, 
default settings such as page size, scan resolution, etc. may not 
be suitable for your scanning needs. You can save yourself time 
and start scanning more quickly by setting custom defaults so that 
the scanner is ready to scan with minimal adjustment.
For more step-by-step instructions on creating custom defaults, 
refer to the online Help (Advanced Scanning).

Special image processing needs

Separate documents with special image processing needs from 
the rest of the original documents. These “special” documents 
may include pages that require special image quality or image 
size adjustments. By separating these documents you can scan 
the common pages quickly as a batch and then devote the time 
needed for making the custom adjustments for the exceptional 
pages.

Scan in Black and White for fastest throughput

Only scan in color or gray modes if you need color or gray output. 
Your scanner is capable of very sophisticated halftone processing, 
allowing it to represent many shades of gray in a smaller, binary 
file.

Be sure Hole Fill is enabled before using Interactive Preview

The Hole Fill operation is performed during the page scan. When 
the page is fed through the Document Feeder, the scanner detects 
the holes by "seeing" the CVT Ski through the holes as the page is 
fed through the Feeder.
If you select Photograph or Photograph & Text mode, the Hole Fill 
feature is automatically disabled. You must select the Hole Fill 
check box on the Image Quality tab to enable the feature.
For more information, refer to the online Help (Advanced 
Scanning).
DocuColor 8000/7000 Operator Manual9-10



10. Technical data

Automatic Document Feeder (ADF)

Maximum paper
dimensions

11.7 x 17 inches (296.7 mm x 431.1 mm)

Minimum paper
dimensions

6.5 x 5.5 inches, short edge feed (165.1 x 139.7 mm)

Throughput Binary Black and white (B/W) (@ 600 dpi):
• 65 images per minute (ipm) single-sided 
• 20 ipm two-sided 
8-bit Grayscale (@ 600 dpi):
• 30 ipm single-sided 
• 20 ipm two-sided 
24-bit Color (@ 400 dpi):
• 20 ipm single-sided 
• 20 ipm two-sided 

Paper Capacity • 100 sheets (20# xerographic bond) 
• 13-32# (49 to 120 gsm) single-sided stock 
• 16-32# (61 to 120 gsm) two-sided stock 

Color spaces & resolutions
supported

• RGB: 72, 75, 96, 100, 120, 150, 200, 240, 300, 400, 600 dpi 
• Production Color (24-bit): 72, 75, 96, 100, 120, 150, 200, 240, 

300, 400, 600 dpi 
• Grayscale: 72, 75, 96, 100, 120, 150, 200, 240, 300, 400, 600, 

1200 dpi 
• Binary B/W: 72, 75, 96, 100, 120, 150, 200, 240, 300, 400, 

600, 1200 dpi 
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10.  Technical  data
Scanner

Platen size 12 x 18 inches (304.8 mm x 457.2 mm) scanning area

Color spaces & resolutions
supported

• RGB: 72, 75, 96, 100, 120, 150, 200, 240, 300, 400, 600 dpi 
• Production Color (24-bit): 72, 75, 96, 100, 120, 150, 200, 240, 

300, 400, 600 dpi 
• Grayscale: 72, 75, 96, 100, 120, 150, 200, 240, 300, 400, 600, 

1200 dpi 
• Binary B/W: 72, 75, 96, 100, 120, 150, 200, 240, 300, 400, 

600, 1200 dpi 

Input document types • Xerographic 
• Lithographic 
• Photographic 
• Inkjet

Optional accessories

Foot switch Functions as a remote "start scan" button. 

6-meter SCSI cable Allows greater distance between scanner and host PC
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11. Maintenance

This chapter provides maintenance information and instructions 
for the various scanner components.
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11. Maintenance
Maintenance intervals

The scanner requires minimal maintenance by the operator. 
However, it is essential that you perform these tasks when 
indicated to ensure reliable operation and maximum product life.

Preventive maintenance intervals 

To avoid any maintenance delays, ensure that you have the 
necessary spare parts and cleaning supplies on hand.

Component Action Maintenance interval

Air Filter Replace • Replace after 3,000 hours.

• The scanner software will notify you when 
the Air Filter requires replacement.

Refer to the online Help (Advanced 
Scanning) for step-by-step 
instructions on replacing the filter.

Feed and Retard 
Rollers

Replace • Replace after 100,000 feeds.

• The scanner software will notify you when 
the Feed and Retard Rollers require 
replacement.

Refer to the online Help (Advanced 
Scanning) for step-by-step 
instructions on replacing the rollers.

Automatic 
Document 
Feeder

Clean Clean the ADF whenever there is paper dust 
visible in the feeder.

Refer to the online Help (Advanced 
Scanning) for step-by-step 
instructions on cleaning the ADF.

Document Glass Clean Clean daily or whenever specks are 
noticeable in scanned images.

Refer to the online Help (Advanced 
Scanning) for step-by-step 
instructions on cleaning the
Document Glass.

Constant Velocity 
Transport (CVT) 
Ski

Clean Clean whenever hole-punch marks are 
noticeable in scanned images.

Refer to the online Help (Advanced 
Scanning) for step-by-step 
instructions on cleaning the CVT Ski.
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11.  Maintenance
Contacting Xerox

Before contacting Xerox for a service problem, perform the 
following steps:

Also refer to the Online Help for additional information and step-
by-step instructions.

1. For image quality problems, first attempt to resolve the 
problem using the image quality troubleshooter.

2. For worn out customer replaceable units, first attempt to 
replace the component yourself.

3. If you have received a message directing you to call for 
service: 
a. Write down the service code. 
b. Locate the scanner serial number and telephone number 

on the Scanner Support Configuration tab. 
c. If there is no telephone number listed on the 

Configuration tab, use the number listed below. 

Telephone numbers and World Wide Web address

Telephone: (Customer Technical Support)
1-800-821-2797

TTY: (Customer Technical Support) 
1-800-821-2797

Supplies Hotline: 1-800-828-5881

Internet: http://www.xerox.com
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11. Maintenance
Spare parts and supplies

Part name Part number

ADF Feed Roller Assembly 600K89591

Air Filter Kit 600K89580

Xerox Platen Glass Cleaner 8R3669
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12. Troubleshooting

This chapter directs you to basic troubleshooting information. This 
troubleshooting information is found in the online Help (Advanced 
Scanning/Help menu/Troubleshooting). The online Help provides 
step-by-step instructions for troubleshooting and fixing various 
problems.

Image quality problems

Image quality problems may include:
• The output image has lines, streaks or other artifacts:

– Output image has a dark line, white narrow streak(s), or a 
distinct edge not present in the original 

– Output image is dark, a "Negative Compression Fault" 
occurs, or the image appears broken up 

– Images or text from the back side of the page shows 
through on the output image 

– Output image has spots or specks 
– Output image has hole punch marks 

• The output image is distorted in some way
– Output image is skewed, stretched, or distorted 
– Output images are inconsistent, despite using the same 

scan settings 
– Output image is posterized (light to dark transitions are 

choppy) 
– Output image seems artificial, or areas around objects in 

the image seem to glow 
– Diagonal edges and other fine details look jagged 
– Output image is blotchy in areas of smooth gradation

For specific information and step-by-step instructions go to the 
online Help: From the Advanced Scanning dialog box, select 
Troubleshooting from the Help menu drop-down list. The online 
Help dialog box opens; click on the Image Quality Problems link.
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12.  Troubleshoot ing
Clearing paper jams and misfeeds

The online Help provides specific step-by-step procedures for 
clearing paper jams and misfeeds from the scanner. You can 
access this information by opening the Advanced Scanning 
feature (click on the Advanced Scanning button from the Scan and 
Print dialog box). From Advanced Scanning, select 
Troubleshooting from the Help menu drop-down list. The online 
Help dialog box opens; click the Clearing Jams & Misfeeds link.
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